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All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use 
with this EPSON printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options 
or any consumable products other than those designated as Original EPSON Products or EPSON Approved 
Products by SEIKO EPSON CORPORATION.

EPSON, EPSON Stylus, and ESC/P are registered trademarks and ESC/P 2 is a trademark of SEIKO EPSON 
CORPORATION. EPSON SoundAdvice, EPSON FaxAdvice, and EPSON Perfect Picture are trademarks of Epson 
America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

Copyright © 1997 by Epson America, Inc. 400667301D0
8/97
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FCC Compliance Statement
For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio or television 
reception. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause interference to radio and television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures.

◗ Reorient or relocate the receiving antenna. 

◗ Increase the separation between the equipment and receiver.

◗ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

◗ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the FCC for 
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables connected to unused 
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to 
operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel brouilleur du 
Canada.
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Introduction

Your EPSON Stylus® COLOR 600 printer is the ideal output 
device for business graphics, single-page layout proofs, digital 
photography—or any project you create on your computer. 
With resolutions up to 1440 by 720 dpi, you get amazingly 
realistic photographic images and vivid graphics in color, superb 
grayscale images, and laser-sharp black printing for crisp text 
and detailed line art.

The printer software for Microsoft® Windows® and 
Macintosh® provides advanced color management, with 
adjustable levels of brightness, contrast, saturation, and ink 
colors. Support for ColorSync™ 2.01 and Windows ICM 
ensures printouts that match the colors on your monitor.

You can also perform many printer maintenance procedures 
right from your computer, such as cleaning and aligning the 
print heads. And EPSON’s extensive online help can guide you 
through printer operations in real time.

With standard parallel and serial ports and simple network 
connectivity, setting up your printer is fast and easy. EPSON’s 
specially formulated ink cartridges and wide variety of ink jet 
papers give you the best quality output and offer the most 
flexibility for getting the results you want.
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Windows System Requirements
To use your printer and its software with a PC, your system 
should have:

◗ An IBM® compatible PC with at least a 386/25 MHz or 
faster processor

◗ DOS, Windows 3.1x, Windows for Workgroups 3.11, 
Windows 95, or Windows NT® 4.0

◗ At least 16MB of RAM

◗ At least 20MB of free hard disk space for storing images 
(50MB or more is recommended)

◗ VGA, Super VGA, or better display adapter and monitor

◗ Double-speed CD-ROM drive (quad-speed or faster 
recommended) for installing the printer software

◗ A shielded, twisted-pair parallel cable (6 to 10 feet long) to 
connect your computer to the printer; the cable must have 
a D-SUB, 25-pin, male connector for your computer and a 
36-pin, Centronics® compatible connector for the printer.

To use the EPSON Answers online guide (not available for 
Windows NT or Macintosh), you need at least a 486/33 
processor. You also should have at least 20MB of free hard disk 
space for full program installation or at least 8MB of free hard 
disk space to run EPSON Answers from the CD. 

For system requirements for the EPSON Perfect Picture™ 
Software Suite, see your Setup Guide.
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Macintosh System Requirements
To use your printer and its software with a Macintosh, your 
system should have:

◗ Any Macintosh or Power Macintosh model except the 
Macintosh +, Macintosh 512, Performa® 410, 
PowerBook® 100, and some early versions of the 
Macintosh, such as the II or Classic

◗ System 7.1 or later

◗ At least 8MB of built-in RAM (16MB or more is 
recommended)

◗ At least 20MB of free hard disk space for storing images 
(40MB or more is recommended)

◗ VGA, Super VGA, or better display adapter and monitor

◗ Double-speed CD-ROM drive (quad-speed or faster 
recommended) for installing the printer software

◗ Standard Apple® System Peripheral-8 cable or equivalent 
(RS-422, 8-pin mini DIN male/male)

For system requirements for the EPSON Perfect Picture™ 
Software Suite, see your Setup Guide. 
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How To Use Your Manuals
To set up your printer and install your printer software, see the 
Setup Guide. This User’s Guide contains the following 
information:

Chapter 1, “Basic Printing,” covers the basics of printing with 
Windows or Macintosh.

Chapter 2, “Custom Printing,” tells you how to print special 
projects with custom settings for print quality and color 
management.

Chapter 3, “Printing on Special Media,” gives guidelines for 
selecting the right paper or other media for your print job and 
instructions for loading it in your printer.

Chapter 4, “Managing Print Jobs and Network Printing,” 
explains how to manage print jobs, check printer status, and set 
up your system for network printing.

Chapter 5, “Maintenance and Transportation,” gives 
instructions for replacing ink cartridges, cleaning and aligning 
the print heads, and cleaning and transporting the printer.

Chapter 6, “Troubleshooting,” provides solutions for any 
printing problems you may have.

The Appendix, “Specifications,” provides the technical details 
on your printer, ink cartridges, and EPSON media.

A Glossary and an Index are included at the end of the book.
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Warnings, Cautions, Notes, and Tips

You’ll find this information throughout your manual:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your 
equipment.

Notes contain important information about your printer.

Tips contain additional hints for great printing.

Where To Get Help
EPSON provides customer support through the following 
services:

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com.

EPSON Internet FTP Site If you have Internet FTP capability, use your Web browser (or 
other software for FTP downloading) to log onto ftp.epson.com 
with the user name anonymous and your e-mail address as the 
password.

EPSON Download Service You can call the EPSON Download Service at (800) 442-2007. Set 
your communications software to 8 data bits, 1 stop bit, no parity. 
Modem speed can be up to 28.8 Kbps.

EPSON Forum on 
CompuServe® 

Members of CompuServe can type GO EPSON at the menu 
prompt to reach the Epson America Forum. For a free 
introductory CompuServe membership, call (800) 848-8199 and 
ask for representative #529.
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EPSON also provides technical support and information on the 
installation, configuration, and operation of EPSON products. 
Dial (800) 922-8911, (310) 782-2600 (U.S.), or 
(905) 709-9475 (Canada), 6 A.M. to 6 P.M., Pacific Time, 
Monday through Friday.

Before you call, please have the following information ready:

◗ Product name

◗ Product serial number

◗ Computer configuration

◗ Description of the problem

You can purchase ink cartridges, paper, manuals, accessories, 
and parts from EPSON Accessories at (800) 873-7766 (U.S. 
sales only). In Canada, please call (800) 873-7766 for dealer 
referral.

ENERGY STAR Compliance
As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy 
efficiency.

Automated telephone services

Service Access

EPSON SoundAdvice™ Pre-recorded answers to commonly asked questions about 
EPSON products 24 hours a day, seven days a week, call 
(800) 442-2110.

EPSON FaxAdvice™ Access EPSON’s technical information library by calling 
(800) 442-2110. You must provide a return fax number to use 
this service.

EPSON Referral Service For the location of your nearest Authorized EPSON Reseller or 
Customer Care Center, call (800) 442-2110.

Note:
If you need help using 
software with an 
EPSON product, see the 
documentation for that 
program for technical 
support information.
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The EPA ENERGY STAR Office Equipment program is a 
voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient 
personal computers, monitors, printers, fax machines, and 
copiers in an effort to reduce air pollution caused by power 
generation. 

Energy-saving Tips

Here are a few tips you can use to be even more energy-wise:

◗ If your monitor isn’t ENERGY STAR compliant, turn it off 
when you’re not using it.

◗ Turn off your computer, printer, and monitor each day 
when you are done using them.

◗ Use the print preview option in your software so you can 
catch errors before you print something.

◗ Send e-mail rather than distributing memos. Not only is 
this faster, but you’ll save paper and storage space too.

Important Safety Instructions
Before using your printer, read the following safety instructions 
to make sure you use the printer safely and effectively.

◗ Turn off and unplug the printer before cleaning. Clean 
with a damp cloth only. Do not spill liquid on the printer.

◗ Do not place the printer on an unstable surface or near a 
radiator or heating vent.

◗ Do not block or cover the openings in the printer’s cabinet 
or insert objects through the slots.

◗ Use only the type of power source indicated on the printer’s 
label.
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◗ Connect all equipment to properly grounded power 
outlets. Avoid using outlets on the same circuit as 
photocopiers or air control systems that regularly switch 
on and off.

◗ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche 
peut être débranchée facilement.

◗ Do not let the power cord become damaged or frayed.

◗ If you use an extension cord with the printer, make sure 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total ampere rating of all devices 
plugged into the wall outlet does not exceed the wall 
outlet’s ampere rating.

◗ Except as specifically explained in this User’s Guide, do not 
attempt to service the printer yourself.

◗ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions: 

If the power cord or plug is damaged; if liquid has entered 
the printer; if the printer has been dropped or the cabinet 
damaged; if the printer does not operate normally or 
exhibits a distinct change in performance. Adjust only those 
controls that are covered by the operating instructions.

Even if you are familiar with other types of printers, be sure to 
read through the following list of precautions before operating 
your ink jet printer:

◗ Do not put your hand inside the printer or touch the 
cartridge during printing.

◗ Under normal circumstances, ink will not come out of the 
cartridges. If it does get on your skin, wash it off with soap 
and water. If it gets in your eyes, flush them immediately 
with water.

◗ Keep ink cartridges out of the reach of children.
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◗ Do not dismantle the ink cartridges or try to refill them. 
This could result in damage to the print head.

◗ Once you install an ink cartridge, do not open the clamp or 
remove the cartridge except to replace it with a new one. 
The cartridge may become unusable otherwise.

◗ Install the ink cartridge immediately after you remove it 
from its package. Leaving the cartridge unpacked for a long 
time before use may result in reduced print quality.

◗ Do not use an ink cartridge beyond the date printed on the 
cartridge carton. For best results, use up the ink cartridges 
within six months of installing them.

◗ Do not shake an ink cartridge; this can cause leakage.

◗ Always turn the printer off using the Ppower button. 
When this button is pressed, the Ppower light flashes 
briefly then goes out. Do not unplug the printer or turn off 
the power to the outlet until the Ppower light is off.

◗ Before transporting the printer, make sure the print head is 
capped in the far right position and the ink cartridges are in 
place.
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It’s easy to print all your color and black and white documents 
with your new EPSON Stylus COLOR 600. First you have to set 
up your printer and install the software, following the 
instructions in the Setup Guide. Then read this chapter to find 
out about the following:

◗ Printing from Windows

◗ Printing from a Macintosh

◗ Printing from DOS

◗ Choosing paper and other media

◗ What to do when the printer lights flash

◗ Using the control panel buttons

◗ Using online help

Printing from Windows
When you want to print from your Windows application, you 
click the print icon or choose Print from the File menu. You 
can then choose which pages to print, the number of copies, 
and other options. The settings that describe your print job—
whether you want to use color or black ink, for example—are 
part of your printer driver software. 

The following sections tell you how to set printer options from 
Windows applications, how to change the default printer 
settings, and how to check your printer’s status.

Basic Printing
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Setting Printer Options from Windows 
Applications

This section describes the preferences you’ll need to set for all 
your everyday printouts. See Chapter 2 for information about 
advanced settings for special print jobs. 

Follow these steps to check printer settings from your word 
processor or other Windows software:

1. Click the print icon or choose Print or Print Setup from 
the File menu. You see a printing dialog box.

If you choose Print, you first see a Print dialog box that 
contains the settings you change most often, including the 
number of copies and the pages you want printed.

2. Make sure your EPSON Stylus COLOR 600 printer is 
selected, and then click the Printer, Setup, Properties, or 
Options button. (You may have to click a combination of 
these buttons.) You see a dialog box like the following:

Note:
The settings you select 
through your Windows 
application apply only 
until you exit that 
application. Then the 
driver settings return to 
the driver’s default values 
or the values selected 
through the Windows 95 
or Windows NT 
Printer Properties or 
Windows 3.1 Control 
Panel.

For more information 
about printer settings, 
click the Help button. In 
Windows 95 and 
Windows NT, you can 
right-click any item on the 
screen and then click 
What’s This?

Main tab
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3. If you do not see the dialog box shown in step 2, click the 
Main tab.

4. Make sure the Mode option is set to Automatic. The 
printer software determines the best settings according to 
the Media Type and Ink settings you make. This is the 
easiest way to get good printing results for all kinds of 
documents, on all types of paper.

5. Choose the Media Type you want to print on from the 
following list (you may need to scroll through the list). If 
you are not sure which setting to select for your media, refer 
to the table on page 3-2.

◗ Plain paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

The type of media you choose determines the print quality 
or resolution you can use. 

6. Choose Color or Black ink. If you are printing black text, a 
draft, or if you want colors to print as varying shades of 
gray, select Black for faster printing.

7. Set the slider to Quality or Speed. This lets you choose 
between the highest resolution or the fastest printing for the 
media you’re using. (The slider is not available for certain 
media types.)

Once you’ve changed these basic settings as needed, check 
the Current Settings box on the bottom of the menu to see 
if the other settings are correct for your document. If you 
need to adjust them, use Advanced mode as described in 
Chapter 2.

For printing at the highest 
resolution (SuperFine 
quality at 1440 dpi), you 
need to use one of the 
photo quality media. For 
the best printing at any 
resolution, always use 
EPSON media.
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8. If necessary, click the Paper tab and choose your paper size, 
number of copies, orientation, and printable area. If your 
software application lets you control these settings, you 
don’t need to use the Paper tab.

9. Click OK when you’re finished checking your settings. The 
dialog box closes.

10. In the printing dialog box, click Close, OK, or Print. You 
may need to click a combination of these buttons.

While your document is printing, the EPSON Despooler 
dialog box appears, showing the printing progress and the 
status of your printer. If you’re using Windows 95, this box 
also displays the Status Monitor. (See “Checking Printer 
Status,” on page 1-6 for more information.)

Setting Default Printer Options

When you change printer settings through your software 
application, the settings apply only to the application you’re 
using. If you want to adjust the default settings for all your 
Windows applications, you can access the dialog box through 
the Windows 95 or Windows NT Settings option or the 
Windows 3.1 Control Panel. 

Make sure all your software applications are closed before you 
start. Otherwise, you’ll have to close and then reopen them to 
have the new default settings take effect.

Setting Default Options in Windows 95

Follow these steps: 

1. Click Start, point to Settings, and then select Printers. 

2. Right-click the EPSON Stylus COLOR 600 icon. 

Note:
To cancel your changes 
and exit the driver, click 
the Cancel button at the 
bottom of the menu at any 
time.

Note:
Some application settings 
override driver settings 
(such as Paper Size or 
Orientation), so it’s a good 
idea to check the settings 
in your application before 
you print.
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3. Select Properties. Then click the Main tab. 

You see the Main printer settings dialog box, as shown on 
page 1-2. 

4. Change the settings you want and click OK. 

Any changes you make will become the default settings for 
all your applications and documents. 

Setting Default Options in Windows 3.1 

Follow these steps: 

1. Double-click the Control Panel icon in the Main group. 

2. Double-click the Printers icon. 

3. Select EPSON Stylus COLOR 600 from the list of printers 
and click Setup. 

You see the Main printer settings dialog box, as shown on 
page 1-2. 

4. Change the settings you want and click OK. 

Any changes you make will become the default settings for 
all your applications and documents. 

Setting Default Options in Windows NT 4.0

1. Click Start, point to Settings, and then select Printers. 

2. Click the EPSON Stylus COLOR 600 icon.

3. Open the File menu and select Document Defaults. You 
see the Main printer settings dialog box.

4. Change the settings as described on page 1-2 and click OK. 
Any changes you make become the default settings for all 
your applications and documents. 

Note:
You can access the 
default Windows NT 
printer software settings 
only if you have the 
appropriate network 
access privileges, such 
as Administrator or 
Power User.
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Checking Printer Status

While your document is printing, the EPSON Despooler dialog 
box appears on your screen:

This dialog box shows the progress of your print job and the 
status of your printer. If you run out of paper while printing, for 
example, the Despooler warns you. You can use the buttons to 
cancel, pause, or restart your print job. 

The Status Monitor at the bottom of the dialog box shows how 
much ink is left in your printer, along with these status icons:

Note:
If you don’t want the 
Despooler dialog box to 
appear each time you 
print, you can turn it off. 
To do this, start Spool 
Manager, open the View 
menu, and select Show 
Despool Popup; the 
checkmark next to the 
option disappears.

The name of 
the file you’re 
printing appears 
hereClick to 

pause printing

Click to cancel 
printing

Click to 
restart printing

Windows 95 
only

Note:
The Status Monitor 
appears only if you’re 
using Windows 95 and 
you’re not printing over 
a network.

Checking the printer status.

A printing error has occurred and your printer 
cannot print. Check your printer or see Chapter 6 
for troubleshooting information.

The printer is ready to print.

The printer is currently printing.

The ink level is low or empty; check the B or A 
ink out light on the control panel and replace the 
cartridge if necessary.
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Printing from a Macintosh
When you set up a new printer for your Macintosh, you need to 
check the printer driver settings for documents in each 
application you use. After you click the print icon or choose 
Print from the File menu, you see dialog boxes that let you 
choose the settings that describe your print job—such as 
whether you want to use color or black ink or the number of 
copies.

This section describes the preferences you’ll need to set for all 
your everyday printouts. See Chapter 2 for information about 
advanced settings for special print jobs. 

Follow these steps to check printer settings from your word 
processor or other Macintosh software:

1. Choose Page Setup from the File menu. You see the Page 
Setup dialog box.

2. Choose your paper size and other page setup options and 
click OK.

3. Choose Print from the File menu or click the print icon in 
your application. You see a dialog box like the following:

4. Choose the number of copies and indicate which pages you 
want to print.

Note:
On the Macintosh, printer 
settings are saved with 
your document, but you 
can’t save them from one 
application to another. 
You’ll have to check 
your settings each time 
you print from a new 
application. If you want 
to reuse settings, you 
can create document 
templates for your favorite 
applications.

Click for more information 
about printer settings

Click to see list 
of media types
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5. Make sure the Mode option is set to Automatic. The 
printer software determines the best settings according to 
the Media Type and Ink settings you make. This is the 
easiest way to get good printing results for all kinds of 
documents, on all types of paper.

6. Choose the Media Type you want to print on from the 
following list. The type of media you choose determines the 
print quality or resolution you can use. If you are not sure 
which setting to select, refer to the table on page 3-2.

◗ Plain Paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

7. Choose Color or Black ink. If you are printing black text, a 
draft, or if you want colors to print as varying shades of 
gray, choose Black for faster printing.

8. Set the slider to Quality or Speed. This lets you choose 
between the highest resolution or fastest printing for the 
media you’re using. 

9. Click Print when you’re finished checking your settings. 

If you chose background printing when you set up your 
printer, you can continue working while your document is 
printing. See “Using Monitor2” in Chapter 4.

For printing at the highest 
resolution (SuperFine 
quality at 1440 dpi), you 
need to use one of the 
photo quality media. For 
the best printing at any 
resolution, always use 
EPSON media.
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Printing from DOS
Most DOS software programs include software for EPSON 
ESC/P 2™ printers. You need to select the correct printer 
software to take advantage of your printer’s advanced built-in 
scalable fonts and graphics handling.

Most DOS programs require you to select from a list of printers 
to install the printer software. If EPSON Stylus COLOR 600 is 
not included in the list, contact your software manufacturer to 
obtain updated software. 

If updated software is not available, pick the first printer 
available in the lists below.

When printing black and color, select:

EPSON Stylus Pro
EPSON Stylus COLOR 500
EPSON Stylus COLOR II
LQ-860
LQ-2550

When printing black only, select:

LQ-870/1170
LQ-500
LQ-570(+)/1070(+)
SQ-870/1070
LQ-850

Note:
The drivers for the printers 
listed do not provide all 
EPSON Stylus COLOR 600 
features, such as 1440-dpi 
printing, 720-dpi printing, 
and MicroWeave.
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Choosing Paper and Other Media
You can use most plain paper with your printer and achieve 
good results. For better results, use EPSON specially coated ink 
jet paper because it provides the best surface for the ink used in 
your printer. EPSON offers specially designed media for EPSON 
ink jet printers, available in a choice of sizes. See Chapter 3 for 
more information on using special media.

To order EPSON papers and other media, contact your dealer 
or call EPSON Accessories at (800) 873-7766 (U.S. sales only). 
In Canada, please call (800) 873-7766 for dealer referral.

Media name Size Part number

EPSON 360 dpi Ink Jet Paper A4
Letter

S041059
S041060

EPSON High Quality Ink Jet 
Paper

A4
Letter

S041117
S041111

EPSON Photo Quality Ink Jet 
Paper

A4
Letter
Legal

S041061
S041062
S041067

EPSON Photo Quality Glossy 
Paper

A4
Letter

S041126
S041124

EPSON Photo Paper 4 × 6 S041134

EPSON Photo Quality Glossy 
Film

A6
A4
Letter

S041107
S041071
S041072

EPSON Ink Jet Transparencies A4
Letter

S041063
S041064

EPSON Photo Quality Ink Jet 
Cards

A6
8 × 10

S041054
S041122

EPSON Iron-On Transfer Paper Letter SE41001, SE41002

EPSON Photo Quality Self 
Adhesive Sheets

A4 S041106
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What To Do When the Printer 
Lights Flash

The four lights on your printer’s control panel show the 
printer’s status and alert you to problems like paper jams. 

power light

black ink out 
light

paper light

color ink out 
light

load/eject
 button

cleaning 
button

power button

S When the paper light comes on, your paper ran out or is 
incorrectly loaded. Load paper in the feeder and then press the 
E load/eject button. 

B A When an ink out light comes on, you need to replace the ink 
cartridge. See Chapter 5 for instructions.

B A When an ink out light flashes, your ink supply is low. Make 
sure you have a replacement cartridge.

S B A When the paper light flashes and the ink out lights are on, you 
have a paper jam. Turn off the printer and gently pull out all 
jammed paper. Reload the paper, then press the E load/eject 
button. 

P The power light is on when the printer is on. The power light 
flashes when the printer is receiving data or charging ink, or if 
you are replacing an ink cartridge or cleaning a print head.

P S B A When the power and paper lights flash and the ink out lights 
are on, your printer has a carriage error. Press the P button 
twice to reset the printer. See Chapter 6 for more information. 

P S B A When all the lights flash, your printer may have an internal 
error. See Chapter 6 for more information. 
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Using the Control Panel Buttons
Follow these guidelines when using the control panel buttons:

Using Online Help
For complete information about using the printer driver, you 
can easily access online help any time. It provides detailed 
descriptions of the different settings and options.

Accessing Help from Windows Applications

To access online help from your application, open the File 
menu and choose Print or Print Setup. Then click Printer, 
Setup, Options, or Properties (you may need to click a 
combination of these buttons) depending on the software you 
are using. Click the Help button at the bottom of the dialog 
box for help related to the items on that dialog box. Then select 
a help topic.

P Turns the printer on and off.

Resets the printer (clears its memory) if pressed twice within 
10 seconds while the power is on.

E Loads or ejects paper if pressed and released within two 
seconds. Resumes printing if pressed after a paper out error is 
corrected.

R Moves the print head to the replacement position if pressed for 
about three seconds while the B or A ink out light is flashing 
or on. Returns the print head to its home position after ink 
cartridge replacement.

Performs print head cleaning if pressed for about three seconds 
when the B or A ink out light is off.
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You can also access online help when you’re not using the 
driver, as described below.

Accessing Help from Windows 95

Click the Start button, point to Programs, and Epson, and 
then click EPSON Stylus COLOR 600 Help. If you need 
instructions for how to use help, read the online “Quick Guide 
to Using Help.”

While you’re using the printer driver, you can get specific help 
related to any item in the menus by right-clicking the item and 
then clicking the What’s This? prompt.

Accessing Help from Windows 3.1 

To access online help from Program Manager, open the EPSON 
program group and click the EPSON Stylus COLOR 600. If you 
need instructions for how to use help, read the online “Quick 
Guide to Using Help.”

Accessing Help from Windows NT 4.0

Click the My Computer icon, then click the Printers icon. 
Right-click the EPSON Stylus COLOR 600 icon and select 
Document Defaults from the menu. In the printer software 
dialog box, click the Help button. If you need instructions for 
how to use help, read the online “Quick Guide to Using Help.”

Accessing Help from Macintosh Applications

Choose Print from the File menu or click the print icon in your 
application. Click the Help button for help related to the items 
on that menu. To exit Help, click the OK button at the bottom 
of the Help screen.

With Windows NT, you 
can get specific help 
related to any item in the 
menus by right-clicking 
the item and then clicking 
the What’s This? prompt.
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When you want to print presentation graphics, photographs, or 
other special projects, you can use the custom settings in your 
EPSON Stylus COLOR 600 software. You can choose 
predefined settings or adjust individual options like brightness, 
contrast, saturation, and halftoning. For professional-quality 
color accuracy, you can use Image Color Matching (ICM) 
under Windows 95 or ColorSync on the Macintosh.

This chapter includes the following information:

◗ Using predefined advanced settings

◗ Customizing print quality and special effects

◗ Customizing color settings

◗ Using ColorSync on the Macintosh

◗ Saving custom settings

◗ Redefining custom settings

◗ Deleting custom settings

Using Predefined Advanced 
Settings
Predefined settings provide an easy way to fine-tune your 
printer’s operation for special projects. Follow these steps to 
print with predefined settings:

1. Create your document, image, or project in your 
application software.

Custom Printing
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2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-7 (Macintosh).

You see one of the following dialog boxes:

3. Select Color or Black Ink.

Note:
When you use 
advanced settings, 
the Quality/Speed 
slider disappears.

Windows

Click Advanced, then click here 
to see a list of project types

Macintosh

Click Advanced, then click here 
to see a list of project types
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4. Click Advanced, and then Custom Settings. You see the 
list of project types.

5. Follow these guidelines to choose the right one for your 
project:

◗ Photo
For printing scanned photographs. Increases contrast 
in the image.

◗ Text/Graph
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

◗ PhotoEnhance
For printing images captured using a video camera, 
digital camera, or scanner. Produces sharper images 
and more vivid colors by automatically adjusting the 
contrast, saturation, and brightness. Corrects for 
overall under- and over-exposure of the original image. 

◗ Economy
For rough drafts of text only, on plain paper. Saves ink. 

◗ ICM (Windows 95 only)
Automatically adjusts printout colors to match the 
colors on your screen. 

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to match the 
colors on your screen. For more information, see 
page 2-9.

6. Choose the Media Type you want to print on. (If you are 
not sure which setting to select, refer to the table on 
page 3-2.) The available media are limited by the project 
you choose. For example, you can’t use plain paper or 
transparencies with the ICM or ColorSync settings.

7. Click OK or Print. If you’re using Windows, click any 
other buttons that your application uses for printing.

Note:
Always choose your Ink 
setting before you select a 
project setting from the 
Custom Settings list.

Selecting PhotoEnhance, 
ICM, or ColorSync 
automatically sets the Ink 
option to Color.

Printing with the 
PhotoEnhance setting 
may take longer, 
depending on your 
computer system and 
image.

The Photo setting and the 
PhotoEnhance setting 
have similar effects. 
However, PhotoEnhance 
intelligently analyzes your 
image data and its effect 
varies widely depending 
on your image.The Photo 
setting consistently 
increases contrast. You 
may have to experiment 
to choose the best setting 
for your needs.
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Customizing Print Quality and 
Special Effects
If you need the maximum control over your project, or you 
want to experiment with special effects, you can adjust 
individual settings in your printer software. Follow these steps:

1. Create your document, image, or project in your 
application software.

2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-7 (Macintosh). 

3. Click Advanced, and then click More Settings. You see 
the More Settings dialog box:

Note:
After you customize your 
print settings for a special 
project, you can save 
them as a group. Then 
you can reuse them 
whenever you print a 
similar project. See 
page 2-11 for instructions.

Windows

Some of these options 
are automatically set 
or disabled by other 
settings you choose
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4. Choose one of the following Print Quality options:

◗ Economy
For low-resolution rough drafts on plain paper. Saves 
ink.

◗ Normal - 360 dpi
For most documents on plain paper, transparencies, or 
360 dpi Ink Jet paper.

◗ Fine - 720 dpi
For high-resolution output. Works best on photo 
quality media.

◗ SuperFine - 1440 dpi
For the highest-resolution output on photo quality 
media only.

5. Choose the Media Type and Ink settings you want to use, 
following the guidelines in Chapters 1 and 3. 

Macintosh

Some of these options 
are automatically set 
or disabled by other 
settings you choose

Note:
The Print Quality is 
selected automatically 
depending on the current 
Media Type. If you choose 
a Print Quality setting that 
is not appropriate for your 
media, the driver changes 
the Media Type setting. 
Be sure to check both of 
these settings.
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6. Choose one of the following Halftoning options:

◗ No Halftoning
For printing black text only.

◗ Error Diffusion
For printing photographic or video/digital camera 
images. Blends each dot of color with the surrounding 
dots.

◗ Fine Dithering, Coarse Dithering
For printing charts, graphs, and other images that 
require precise, solid areas of bright colors. Arranges 
dots in orderly patterns. Use Coarse for images with 
more shading and less detail. Use Fine for images with 
more detail and less shading.

7. Choose any of the following options. Some of these settings 
are automatically selected or disabled by the Print Quality 
(resolution) you choose.

◗ MicroWeave
For improved print quality. Prints graphic data in finer 
increments to eliminate unwanted banding effects 
(light horizontal lines). Always use for color printing.

◗ High Speed
For fast, bidirectional printing at lower quality.

◗ Flip Horizontal
Prints a mirror image of your document. Use for 
printing with iron-on transfer paper. When you iron 
the printout onto a T-shirt or other item, it will read 
correctly.

◗ Finest Detail
For printing text, graphics, and line art with very sharp 
edges. Slows print speed and increases your system 
memory requirements. 

8. Click OK if you’re ready to print, or see the next section if 
you want to adjust your printer’s color settings.

Note:
In Automatic mode, the 
Halftoning setting is 
selected based on the 
data in your print job. In 
Advanced mode, 
Halftoning is preselected 
for each document type 
setting. No Halftoning is 
available only when you 
select Black as the Ink 
setting.

If vertical lines in your 
printout are misaligned 
when you use the High 
Speed setting, you may 
need to align the print 
heads. See Chapter 5 for 
instructions.
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Customizing Color Settings
You can choose from several color adjustment modes or 
manually adjust brightness, contrast, and saturation. For 
professional color correction, you can set individual CMY color 
values. To achieve the maximum color accuracy, you can use 
Image Color Matching (ICM) under Windows 95, ColorSync 
on the Macintosh, or PhotoEnhance (Windows and 
Macintosh).

Follow these steps to customize your color settings:

1. Access the More Settings dialog box as described on 
page 2-4.

The color settings appear on the right side of the dialog 
box, as shown:

Click to set Color Adjustment Mode

Drag sliders to 
set values 
between -25% 
and +25%

Macintosh

Windows 
(ICM is available only for Windows 95)
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2. Choose one of the following Color Adjustment Modes:

◗ Automatic
Analyzes the color information in your project and 
optimizes color correction accordingly.

◗ Photo-realistic
For printing color photographs. 

◗ Vivid
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

◗ No Color Adjustment
With Windows, disables the color adjustment features 
of the printer software so you can adjust colors using 
your application. On a Macintosh, choose this mode 
only if you’re using ColorSync.

3. If you want to specify individual color correction values, 
use the scroll bars to increase (drag right) or decrease (drag 
left) the settings listed below. (If you use one of the options 
described in step 4, you won’t be able to specify individual 
color correction values.)

◗ Brightness
Makes your image lighter or darker.

◗ Contrast
Increases or decreases the difference between the bright 
or dark parts of an image.

◗ Saturation
Makes colors more vivid or less vivid.

◗ Cyan, Magenta, Yellow
Increases or decreases the amount of the three ink 
colors that combine to make a full-color picture. Use to 
fine-tune the color balance in your printout.
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4. For even more fine-tuning, choose PhotoEnhance, ICM 
(Windows 95), or ColorSync (Macintosh).

◗ PhotoEnhance
Produces sharper images and more vivid colors by 
automatically adjusting the contrast, saturation, and 
brightness. Corrects for overall over- or under-exposure 
of the original photograph.

◗ ICM (Windows 95 only)
Automatically adjusts printout colors to match colors 
on the screen. 

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to match colors 
on the screen. See “Using ColorSync on the 
Macintosh” for more information.

5. Click OK to return to the Main printer settings dialog box.

6. Click Save Settings if you want to save your custom 
settings as a group that you can reuse for special projects. 
See page 2-11 for more information about saving settings.

7. Click OK (Windows) or Print (Macintosh). If you’re using 
Windows, click any other buttons that your application 
uses for printing.

Using ColorSync on the Macintosh
Every device you use for viewing or producing colors—your 
monitor, scanner, and printer—uses a different color 
technology. That’s why it’s difficult to get printed colors to 
match the colors displayed on your monitor. The Macintosh 
ColorSync system calibrates your monitor so its colors match 
your printer’s as closely as possible. 

Note:
When you choose 
PhotoEnhance, ICM, or 
ColorSync, all the other 
color options are preset.

The availability of ICM 
depends on your Print 
Quality, Media Type, and 
Halftoning settings.
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ColorSync uses profile information from each device—
including your EPSON Stylus COLOR 600—to achieve 
accurate color matching. First you have to make sure your 
monitor’s profile is set. Then you can use your printer software 
to specify the exact method of color matching you want to use.

Follow these steps to set your monitor’s ColorSync profile and 
use your printer software’s ColorSync features:

1. Open ColorSync System Profile under Control Panels 
on the Apple menu.

2. Click the Set Profile button.

3. Select your monitor from the list, and then click Select.

4. Close ColorSync System Profile.

5. Access the More Settings dialog box as described on 
page 2-4. 

6. Click ColorSync.

7. For Profile, choose EPSON Standard.

8. Choose one of the following options for Rendering Intent:

◗ Perceptual
For printing photographs.

◗ Saturation
For printing graphics-intensive documents like 
presentation pages with charts and graphs.

◗ Colorimetric
For matching colors as precisely as possible. 
Reproduces colors the way your eye distinguishes them.

9. Click OK, and then click Print.

Note:
The EPSON Standard 
profile is custom-
designed for your printer. 
If you use a scanner or 
other color imaging 
equipment, you may have 
other profiles available.
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Saving Custom Settings
After you’ve fine-tuned your printer settings for a special 
project, you can save the settings as a group with a unique name 
and add it to the Custom Settings list. Then you can easily 
select the settings the next time you print a similar project. 
Follow these steps:

1. Customize your printer settings as described in this chapter.

2. Click the Save Settings button on the Main printer 
settings dialog box. 

You see one of the following: 

3. Type a unique name for your settings (up to 16 characters) 
and click the Save button.

The name you choose will now be available on the Main printer 
settings dialog box when you click Advanced, and then 
Custom Settings.

Note:
You can save up to 
10 groups of settings.

If you change the Media 
Type or Ink setting when 
your customized setting is 
selected, the setting 
selected in the list 
changes to Custom 
Settings. This does not 
affect your customized 
setting. To return to 
your customized setting, 
simply reselect it.

Macintosh

Windows
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Redefining Custom Settings
To change the options in a customized setting group but keep 
the same name for it, follow these steps:

1. Select Advanced mode. 

2. Select the name of the custom settings group you want to 
redefine in the Custom Settings list.

3. Change the printer settings as necessary. (If you change the 
Media Type and Ink settings, the custom settings group 
name reverts to Custom Settings; this doesn’t affect your 
customized setting.)

4. Click Save Settings.

5. Select the name of the custom settings group you’re 
redefining in the Custom Settings box.

6. If you’re using Windows, click Save. You see the Save As 
dialog box. Click OK to save your redefined settings. (Click 
Cancel to cancel your changes.)

On a Macintosh, click the Redefine button. Then click 
Replace at the confirmation dialog box to save your 
redefined settings. (Click Cancel to cancel your changes.)

Deleting Custom Settings
If you no longer need your customized settings, follow these 
steps to delete them:

1. Select Advanced mode. 

2. Click Save Settings.

3. Select the custom settings group in the Custom Settings 
box, and click Delete. (You cannot delete any of the 
predefined document types.)
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Your EPSON Stylus COLOR 600 lets you print on just about 
any kind of paper you want to use. You can get great results 
printing on various sizes of plain paper, letterhead, and 
envelopes. You’ll get even better results with specially coated 
ink jet paper. For the best output, use EPSON’s photo quality 
media: ink jet paper, glossy paper, glossy film, index cards, and 
photo paper.

For special projects, you can use a variety of EPSON media 
designed for ink jet printers, ranging from transparencies to 
iron-on transfer paper. You can even set up your printer to use 
custom paper sizes to print large posters and banners. This 
chapter covers the following:

◗ Using special media

◗ Printing banners and other custom size projects

Using Special Media
The type of paper or other media you use is one of the most 
important factors in determining the quality of your printed 
output. For example, you can achieve the highest resolution 
(SuperFine quality at 1440 dpi) only when you use EPSON 
Photo Quality media. The following tips will help you get the 
best results on any type of paper or other media. For additional 
information, see the specific section for the media you are using.

Printing on
Special Media
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Media Loading and Software Settings 
Guidelines

Whether you print on plain paper or special media, you need to 
load it according to the guidelines in the table below. You must 
also be sure to select the correct Media Type setting in your 
printer software to match the media you loaded. See page 3-3 
for additional guidelines.

When you load media with this 

name . . .

Load a maximum of this 

many sheets . . .

Then select this Media 

Type setting in your 

printer software . . .

Plain paper (single sheets) 100 letter size Plain paper

Envelopes (remember to set the 
adjust lever forward)

101

Labels (single sheets)

EPSON 360 dpi Ink Jet Paper 70 letter size
30 legal size

360 dpi Ink Jet Paper

EPSON Special Coated Paper for 
360 dpi Printing

EPSON High Quality Ink Jet Paper 70 letter size
30 legal size

Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet 
Paper

EPSON Special Coated Paper for 
720 dpi Printing

EPSON Photo Quality Ink Jet 
Cards 

30 cards1

EPSON 720 dpi Index Cards 

EPSON Photo Quality Self 
Adhesive Sheets

1

EPSON Photo Quality Glossy 
Paper

20 letter size Photo Quality Glossy Paper

EPSON Photo Paper 201
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1 Load with the short edge leading into the feeder.
2 Use the Flip Horizontal option to reverse your image before you print it—especially if it includes 

text—so the image will appear correctly when it’s transferred. See Chapter 2 for instructions.

Additional Media Loading Guidelines

◗ If the corresponding Media Type option for your paper is 
not shown in the Media Type list, change the Print 
Quality setting in the More Settings dialog box, select 
Automatic as the Mode setting, or change the predefined 
setting in the Custom Settings list on the Main menu. See 
Chapter 2 for more information.

◗ In addition to the Media Type option, remember to select 
the correct Paper Size for your media.

◗ Some special media have a cut corner that you need to 
position correctly; follow any instructions in the package. 
Always handle sheets by the edges, and don’t touch the 
printable surface.

If the special media has protective sheets between each sheet 
of media, be sure to remove the protective sheets before 
printing.

◗ Be sure to load the printable side of the media face up with 
the top edge leading into the printer.

◗ Use ink jet papers within one year of purchase. Use glossy 
media and transparencies within six months. Return 

EPSON Photo Quality Glossy Film 
(use with support sheet)

30 letter size Photo Quality Glossy Film

EPSON High Quality Glossy Paper 
(use with support sheet)

30 letter size

EPSON Ink Jet Transparencies 
(use with support sheet)

10 letter size Ink Jet Transparencies

EPSON Iron-On Transfer Paper2 1 sheet

When you load media with this 

name . . .

Load a maximum of this 

many sheets . . .

Then select this Media 

Type setting in your 

printer software . . .
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unused sheets and envelopes to their original packages as 
soon as possible. See the Appendix for more media storage 
information.

◗ Some EPSON media include a cleaning sheet. Do not use 
the cleaning sheets with this printer. They may damage the 
printer.

Letterhead, Pre-printed Forms, and 
Legal-size Paper

Always load the top edge first. If you are loading long paper, 
pull out the paper support extension and both output tray 
extensions. Don’t load it more than half way to the arrow mark 
on the left edge guide.

EPSON 360 dpi, High Quality, and Photo 
Quality Ink Jet Paper

You can load paper up to the arrow mark on the left edge guide. 
If you use legal-size ink jet paper, don’t load it more than half 
way to the arrow mark.
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EPSON Photo Quality Glossy Paper, Film, 
and Transparencies

To print on transparencies, remove the paper support and 
reinstall it in the rear paper support slot. For glossy paper and 
film, leave the paper support in the normal position.

Before you load glossy film or transparencies, put a support 
sheet (packed with the media) or a plain paper sheet beneath the 
stack. Do not use a support sheet with Photo Quality Glossy 
Paper. 

You can load up to 20 sheets of glossy paper, up to 30 sheets of 
glossy film, or up to 10 transparencies. However, you may get 
better results by loading one sheet at a time. With multiple 
sheets loaded, the minimum top margin you can use is 
1.2 inches. If you want to use a smaller top margin, load and 
print one sheet at a time.

Remove each sheet from the output tray immediately after it’s 
printed. Make sure each sheet is dry before stacking it. If your 
media package included protective sheets, cover the printed side 
of your media with these sheets before stacking. 

Note:
Use ink jet papers within 
one year of purchase. Use 
glossy media and 
transparencies within six 
months. Return unused 
sheets and envelopes to 
their original package as 
soon as possible. See the 
Appendix for more storage 
information.
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EPSON Photo Paper

You can use these cards to print photographs that look almost as 
good as the ones you get from film processing. EPSON Photo 
Paper (4 × 6 inches) is perforated around the edges, so you can 
trim your printouts and “bleed” the photo—extend it to the 
edge of the paper—on all sides. 

You can load up to 20 sheets of EPSON Photo Paper at a time. 
Make sure you place the included support sheet beneath the 
stack, but don’t print on it. Keep the following in mind when 
using EPSON Photo Paper:

◗ Load the paper with the whiter side facing up and the 
perforated margins positioned as shown:

◗ When you create the image in your application software, 
size it to 4.25 × 6.25 inches. Note that the outside edges of 
your image will be cut off when you remove the perforated 
margins.

trim size

printed image size

0.67 in

0.24 in

0.12 in

0.24 in0.12 in
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◗ Choose EPSON Photo Paper 4 × 6 in as the Paper Size 
setting and Maximum as the Printable Area setting.

◗ Choose Photo Quality Glossy Paper as the Media Type 
setting.

◗ After you print your picture, fold the paper back and forth 
along the perforations and carefully tear the margins off.

You can use the EPSON Photo Paper like a postcard. Simply  
print your image on the glossy side of the paper using the 
Photo Quality Glossy Paper Media Type setting and let your 
image dry. Then print your message on the uncoated side of the 
paper using the 360 dpi Ink Jet Paper Media Type setting.

To keep your printouts looking their best, store them in a 
resealable plastic bag or other airtight covering and protect 
them from heat, humidity, and direct sunlight.

EPSON Photo Quality Ink Jet Cards

You can load up to 30 cards at a time with a support sheet 
(packed with the cards) or a sheet of plain paper beneath the 
stack. When you’re ready to print, use your software to set the 
Paper Size option for the size card you’re using.

If ink smears on the cards, set the adjust lever to the + position 
as shown on page 3-9.

EPSON Photo Quality Self Adhesive Sheets

Use these sheets to print labels or stickers. You should load 
these media one sheet at a time. Make sure your adhesive sheets 
are fully adhered to their backing sheet before you load them.
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EPSON Iron-On Transfer Paper

You can print photos, company logos, or anything else you 
want on this paper, and then transfer your images to T-shirts or 
other cloth items. Load one sheet of transfer paper at a time and 
select Ink Jet Transparencies as your media type in your 
printer software. After you print, follow the instructions that 
came with the paper to iron the image onto the shirt or other 
item.

Envelopes

You can load up to 10 envelopes as shown below:

For iron-on transfers, 
make sure you reverse 
your image before you 
print it, especially if it 
includes text. Then the 
text will read correctly 
when it’s transferred. 
You can use the Flip 
Horizontal option in your 
printer software, as 
described in Chapter 2.
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If ink smears when you print on envelopes or other thick media, 
set the adjust lever to the + position. Open the printer cover and 
position the lever as shown below. Then close the cover and 
print. (Make sure you return the lever to the 0 position before 
you print on thin media.) 

Printing Banners and Other 
Custom Size Projects
You can use banner paper or ordinary (continuous-form) 
computer paper to print a banner up to 44 inches long. You can 
also print on any size paper that fits into the printer (at least 
3.94 × 3.94 inches), by using the custom page size feature of 
your printer software on either a Windows computer or a 
Macintosh.

1. To make a 44-inch banner with continuous-form computer 
paper, first tear off four sheets and remove the perforations 
at the edges. If you are using banner paper, cut the paper to 
the length you want for easier handling.

Note:
Be sure to load the 
envelope flap edge first 
and printable side up.

In the printer driver, set 
the Paper Size to the 
correct envelope size.
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2. Insert the paper in the printer as shown. The right edge of 
the paper should be against the right edge guide:

3. Slide the left edge guide next to the left edge of the paper.

4. Follow the instructions in the next sections to print your 
banner on either a Windows computer or a Macintosh.

Printing a Banner from Windows

Follow these steps to print a banner or other custom-size 
document on a Windows computer:

1. Create the document in your word processor or other 
application software. You can create a banner in either 
portrait or landscape orientation. 

2. Click the print icon or choose Print or Print Setup from 
the File menu. You see a printing dialog box.

3. Make sure your printer is selected, and then click the 
Printer, Setup, Properties, or Options button. (You may 
have to click a combination of these buttons.) You see the 
Main printer settings dialog box, as shown on page 1-2.

right edge guide
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4. Click the Paper tab. You see a dialog box like the 
following:

5. Choose the paper you want to use from the Paper Size 
list. If you want to print a banner or other custom-size 
document, choose User Defined. 

If you choose User Defined, the following dialog box 
appears:

6. To print a banner, type 8.5 inches for the Paper Width 
and 44 inches for the Paper Height. (This works for both 
“landscape” and “portrait” style banners.) Click OK.

7. Choose Portrait or Landscape if you haven’t already 
specified the orientation in your application software. Set 
the printable area if necessary.

Click to display 
list of paper sizes

For banner printing, type 
any size up to 44 inches
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8. Click the Main tab to return to the Main printer settings 
dialog box. Make sure you choose Plain paper and the 
other settings you want to use, and then click OK. 

9. Click Close, OK, or Print to print your banner. You may 
need to click a combination of these buttons.

Printing a Banner from a Macintosh

Follow these steps to print a banner or other custom-size 
document on a Macintosh:

1. Create the document in your word processor or other 
application software. You can create a banner in either 
portrait or landscape orientation. 

2. Choose Page Setup from the File menu. 

You see a dialog box like the following:

3. Choose Portrait or Landscape, depending on the 
orientation of the banner or document you created. Set the 
printable area if necessary.

Click to display list of paper sizes

Click to define your 
own paper size
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4. Choose the paper you want to use from the Paper Size list. 
If you want to print a banner or other custom-size project, 
click the Customize button. The following dialog box 
appears:

5. Click the New button. The dialog box changes:

6. Type a name for your custom size in the New Paper Size 
box. 

7. To print a banner, type 8.5 inches for the Width and 44 
inches for the Height. (This works for both “landscape” 
and “portrait” style banners.) Click OK, then OK again.

8. Choose Print from the File menu or click the print icon in 
your application. You see a printer settings dialog box like 
the one shown on page 1-7. 

9. Make sure you choose Plain Paper and the other settings 
you want to use, and then click Print to print your banner. 

Click to 
create a new 
paper size

Type a name 
for your size 
here

You can create up to eight 
custom paper sizes. If you 
give each one a unique 
name, you’ll be able to 
reuse them by selecting 
them from the Page Size 
list in the Page Setup 
dialog box.
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Your printer software includes several utilities for managing 
print jobs. You can use them to monitor your printer’s status, 
set up large jobs to print later, and handle network printing. If 
you’re using your printer on a network, you need to follow the 
special setup procedures in this chapter. 

This chapter provides instructions for the following:

◗ Managing print jobs in Windows 95 or 3.1

◗ Managing print jobs in Windows NT 4.0

◗ Managing print jobs on a Macintosh

◗ Network printing on a PC

Managing Print Jobs in 
Windows 95 or 3.1
Your Windows printer software includes two management 
utilities: the Spool Manager and Status Monitor. 

◗ The Spool Manager starts automatically when you send a 
job to the printer. It allows you to print in the background 
while you continue to work on your computer and to hold 
jobs to print at a later time. If you’re using your printer on a 
network, it also handles multiple print jobs that come in at 
the same time.

Managing
Print Jobs and

Network Printing
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◗ The Status Monitor, which is available only if you’re using 
Windows 95, also starts automatically when you send a job 
to the printer. It displays on your screen to alert you about 
printer and ink status, as described on page 1-6. 

Using the Spool Manager

The Spool Manager works like the Windows Print Manager. 
When you send a job to your printer, your printer software 
creates a temporary print job file, stores it in the C:\TEMP or 
C:\WINDOWS\TEMP folder or directory, and assigns it to a 
print queue. The software then sends the file to your printer at 
the right time.

◗ To open the Spool Manager while you’re printing, click 
the Spool Manager icon that appears on the Taskbar 
(Windows 95) or at the bottom of your desktop 
(Windows 3.1). 

◗ To open it at any time, double-click the Spool Manager4 
icon in the EPSON program group or folder.

You see the Spool Manager window:

The Spool Manager window displays the status of your print 
queues and print job files and lets you control them. Here are 
some of the things you can do:

◗ Hold or release a queue

◗ Send print jobs to your printer over a network 

◗ Hold, re-queue, or delete a print job

Note:
The Status Monitor 
doesn’t appear if you’re 
printing over a network.

In Windows 3.1, you 
may not see the Spool 
Manager icon if the 
Program Manager or 
current window is 
maximized. Make the 
window smaller to see 
the Spool Manager icon.

menus

print job
queue
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◗ Select the information you want to see in the Spool 
Manager window

◗ Prevent the Despooler popup window from appearing on 
your screen whenever you print

◗ Change your default spool directory

Deleting a Stalled Print Job

If you’re having trouble printing, it may be because of a stalled 
print job. Follow these steps to delete it so you can continue 
printing:

1. Open the Spool Manager as described on page 4-2.

2. Click on any print jobs marked Held, then open the 
Document menu and click Delete. 

3. Click Yes.

4. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message when you try to print, or printing is 
very slow, you can try changing your default spool directory. 
Follow these steps:

1. Make a directory on your hard disk where you want Spool 
Manager to store print jobs, for example, C:\SPLTEMP.

2. Open the Spool Manager as described on page 4-2.

3. Make sure EPSON Stylus COLOR 600 is selected, and then 
choose Setup from the Queue menu. The Queue Setup 
dialog box appears.

For information about any 
of these procedures, use 
the Spool Manager Help 
menu.

printjob.fm5  Page 3  Thursday, July 24, 1997  3:05 PM



Managing Print Jobs and Network Printing

4-4

4. Make sure the spool directory is the one you created in 
step 1. Also make sure Use Print Manager for this port is 
checked. Then click OK. (If you are using Windows 95 and 
don’t see the Status Monitor when you print, make sure it’s 
unchecked.)

5. Choose Default Spool Directory from the Options menu. 

6. In the dialog box, change the spool directory to the one you 
created in step 1. Then click OK.

7. Close Spool Manager.

Using the Status Monitor

The Status Monitor, available only if you’re using Windows 95, 
displays automatically when you send a job to the printer. 
However, you can use it at any time to see how much ink you 
have left. Follow these steps:

1. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-7 (Macintosh).

2. Click the Utility tab. You see the Utility menu:

Note:
The Status Monitor is not 
available if you are printing 
over a network or if the 
Use Print Manager for this 
Port option is selected in 
the Control Panel, 
Printers window.

For information 
about these 
three utilities, 
see Chapter 5
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3. Click the EPSON Status Monitor icon. You see the 
Despooler window with the Status Monitor at the bottom:

4. Check the amount of ink you have left. For more 
information about the Despooler window, see page 1-6.

Managing Print Jobs with 
Windows NT 4.0
Windows NT 4.0 servers and workstations include a messenger 
service to alert you to printer errors or let you know when a 
print job is finished. If you have appropriate network access 
privileges or you’re controlling printing from the server, you 
can also cancel, pause, or restart print jobs and set the sharing, 
security, scheduling, and port options. See your Windows NT 
documentation for details.
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Managing Print Jobs on a 
Macintosh
Your Macintosh printer software includes two management 
utilities: Monitor2 and Status Monitor. 

◗ If you’re using background printing, Monitor2 starts 
automatically when you send a job to the printer. It handles 
printing while you continue to work on your Macintosh 
and lets you track documents that are waiting to be printed. 

◗ The Status Monitor alerts you to any problems that occur 
during printing. You can also use it at any time to see how 
much ink you have left. 

Using Monitor2

The Monitor2 utility lets you continue to work on your 
Macintosh while your document is printing. However, 
background printing is slower and may also slow down your 
system. 

If you want to use this utility, you need to turn on background 
printing in the Chooser and increase the memory allocation for 
Monitor2. Follow these steps:

1. Open the Chooser from the Apple menu and select the 
EPSON Stylus(EX) icon. Then click either the printer or 
modem icon.

2. Under Background Printing, click On and close the 
Chooser.

3. To increase the memory allocated to Monitor2, select 
EPSON Monitor2 in the Extensions folder in your System 
folder.
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4. Choose Get Info from the File menu.

5. Set the Memory Requirements to 2000K or 3000K, 
depending on your system’s available RAM.

6. While you’re printing, click the EPSON Monitor2 icon on 
the Application menu at the right end of the menu bar. You 
see a dialog box like the following:

7. You can select a job and cancel it or just use this window to 
track the printer’s progress.

Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in your 
printer and to control the way your software warns you about 
printer problems. Follow these steps:

1. Choose Print from the File menu or click the print icon in 
your application. You see the printer settings dialog box.

Job currently 
printing

Jobs queued 
for printing 
appear here
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2. Click the Utility button. You see the Utility menu:

3. Click the EPSON Status Monitor icon. The software 
checks the amount of ink remaining in the printer and 
displays the Status Monitor window:

For information 
about these 
three utilities, 
see Chapter 5

Click to recheck 
ink level

Click to control messages 
and warnings
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4. If you want to change printer messages and warnings, click 
the Configuration button. 

You see the following dialog box:

5. Choose the options you want and click OK.

Network Printing on a PC
You can use your printer on a network under Windows NT, 
Windows 95, or other network operating systems. First you 
need to set up your printer using either the network’s printer 
setup functions or your printer software’s built-in network 
support. 

For instructions on using the printer software’s network 
support, see “Using the Printer Software’s Built-in Network 
Support.”

Network Printing with Windows NT 4.0

If you connected the printer directly to a Windows NT 4.0 
server, see your Windows NT documentation for instructions 
on configuring your printer for the network.
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Using the Printer Software’s Built-in 
Network Support

To use your printer software’s built-in network support, you 
first need to install the printer driver software on all the network 
computers that will use the printer. See the Setup Guide for 
instructions. Once the printer software is installed, you can set 
up Spool Manager to send print job files from each computer to 
a shared directory on the computer connected to the printer. 

Follow the steps in the next sections to set up a print job 
directory on the system connected to the printer (the host 
system) and each remote system (client) on the network. For 
Windows 95, you also need to specify the port and network 
path to the printer, as described on page 4-11.

Setting Up the Host System

Follow these steps to set up the computer connected to the 
printer:

1. Create an icon for the EPSON Spool Manager4 
(EPSPMGR4.EXE in the \WINDOWS\SYSTEM folder 
or directory).

2. Place this icon in the Startup folder.

3. Double-click the EPSON Spool Manager4 icon to open 
the Spool Manager window.

4. Double-click the EPSON Stylus COLOR 600 print queue. 
The Queue Setup dialog box appears.

5. Click the Remote Despool tab and then click the 
Printing from remote queues option.

6. Click the Browse button and select the remote server 
directory that will receive print job files.

7. Click OK and minimize the Spool Manager window.
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Setting Up Remote Systems

Follow these steps to set up the client computers on the 
network:

1. Open the Spool Manager window as described on page 4-2.

2. In the Spool Manager window, double-click the EPSON 
Stylus COLOR 600 print queue. The Queue Setup dialog 
box appears.

3. Click the Spool to remote printer button.

4. Click the Browse button and select the directory you’re 
using for print job files on the host system.

5. Click OK and minimize the Spool Manager window.

Setting Up Your Network Path in Windows 95

If you want to use your printer on a network running 
Windows 95, you need to set up the port and network path on 
the computer connected to the printer. Follow these steps:

1. Double-click My Computer.

2. Double-click the Printers folder.

3. Right-click the EPSON Stylus COLOR 600 icon and choose 
Properties.
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4. Click the Details tab. The following dialog box appears:

5. Click the Add Port button, then specify the network path 
to the printer and click OK.

6. Open the Spool Manager window as described on page 4-2.

7. In the Spool Manager window, double-click your printer’s 
queue. The Queue Setup dialog box appears.

8. Make sure the Use Print Manager for this port option is 
checked. Then click OK.

Note:
If you want to print from 
DOS applications as well 
as from Windows 
applications, click the 
Capture Printer Port 
button instead of the 
Add Port button. In the 
Device box, select the 
printer port your printer 
is connected to, then 
specify the network path 
to the printer. Make sure 
Reconnect at logon is 
selected, then click OK.
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It’s easy to keep your EPSON Stylus COLOR 600 printer 
working at its best. Just follow the simple instructions in this 
chapter for replacing ink cartridges, moving the printer, and 
performing routine maintenance. 

This chapter covers the following procedures:

◗ Cleaning the print heads

◗ Replacing an ink cartridge

◗ Aligning the print heads

◗ Cleaning the printer

◗ Transporting the printer

Cleaning the Print Heads
If your printed image is unexpectedly light or faint, or dots are 
missing from the image, you may need to clean the print heads. 
This unclogs the nozzles so they can deliver ink properly.

Cleaning the print heads uses ink, so clean them only if print 
quality declines. You can use either of the following to clean the 
print heads:

◗ The Head Cleaning utility in your printer software

◗ The printer’s control panel buttons. 

Maintenance and
Transportation
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Using the Head Cleaning Utility

Follow these steps to run the utility from a Windows computer 
or a Macintosh:

1. Make sure the printer is turned on but not printing, and 
the B black and A color ink out lights are off.

2. Access the Main printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Head Cleaning icon.

5. Follow the instructions on the screen to clean the print 
heads. Cleaning each head takes about two minutes, during 
which the printer makes some noise and the Ppower light 
flashes. 

When the Ppower light stops flashing, you need to run a 
nozzle check to test the print quality and reset the cleaning 
cycle.

6. Make sure paper is loaded in the printer and click Print 
nozzle check pattern (Windows) or Confirmation 
(Macintosh), and then click Next. See page 5-4 for 
instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If 
you don’t notice any improvement after doing this two or three 
times, check the print quality solutions in Chapter 6.

Note:
Wait until your printer has 
finished printing before 
using this utility.

Do not use this utility with 
printers on a network.

Caution:
Never turn off the printer 
while the Ppower light is 
flashing.

If however, the Ppower 
light is still flashing after 
10 minutes and the 
printer is not moving or 
making noise, you may 
turn off the printer.
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Using the Control Panel

1. Make sure the printer is turned on and not printing, and 
that the B black and A color ink out lights are off.

2. Press the R cleaning button and hold it for three seconds. 
Cleaning takes about two minutes, during which the 
printer makes some noise and the Ppower light flashes. 

3. After the cleaning cycle is complete and the Ppower light 
stops flashing, you need to print a test page to test the print 
quality and reset the cleaning cycle. 

If you’re using DOS, open an application and print a 
document containing black and color data. Then go to 
step 7.

Otherwise, run a nozzle check. Go to step 4.

4. Access the Main printer settings dialog box as described in 
Chapter 1.

5. Click the Utility tab (Windows) or the Utility button 
(Macintosh), and then click Next. You see the Utility 
menu.

6. Click the Nozzle Check icon. See the next section for 
instructions on examining the nozzle check pattern.

7. If your print quality has not improved, repeat the steps 
above. If you don’t notice any improvement after doing this 
two or three times, check the print quality solutions in 
Chapter 6.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look 
something like this, with the lower pattern colored cyan, 
magenta, and yellow:

Each staggered horizontal and straight vertical line should be 
complete, with no gaps in the dot pattern. If your printout 
looks okay, you’re done. If any dots are missing, clean the print 
heads again, as explained in the previous sections.

Replacing an Ink Cartridge
When a B black or A color ink out light flashes, the indicated 
cartridge is low on ink. This is a good time to make sure you 
have a new cartridge. When the light stays on, the cartridge is 
empty and you need to replace it.

Use these EPSON ink cartridges within six months of installing 
them and before the expiration date on the package:

Black ink cartridge S020093
Color ink cartridge S020089

When you need new ink cartridges, contact your dealer or call 
EPSON Accessories at (800) 873-7766 (U.S. only). In Canada, 
please call (800) 873-7766 for dealer referral.

W0186B

Caution:
For best results, don’t 
replace an ink cartridge 
unless its ink out light is 
flashing or on.

If ink runs out, you can’t 
continue printing, even if 
ink remains in the other 
cartridge.

To ensure good results, 
use genuine EPSON 
cartridges and do not refill 
them. Other products may 
cause damage to your 
printer not covered by 
EPSON’s warranty.
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Removing an Empty Ink Cartridge

You can replace a cartridge when the B black or A color ink 
out light is either flashing or on. Follow these steps:

1. Make sure the printer is turned on and not printing. 

2. Determine which cartridge needs to be replaced.

3. Lower the output tray and raise the printer cover. 

4. Press the R cleaning button and hold it for three seconds. 

The print heads move slightly left and the P power light 
begins flashing. (The print heads return to their home 
position if you don’t proceed to step 5 within 60 seconds.)

5. Pull up the ink cartridge clamp. The cartridge rises up from 
its holder. (Although the illustration shows the color ink 
cartridge, the procedure is the same for replacing the black 
ink cartridge.)

6. Lift the cartridge out of the printer and dispose of it 
carefully. 

7. Follow the steps in the next section to install the new ink 
cartridge.

Caution:
If you press the R 
cleaning button when no 
ink out light is flashing or 
on, the printer cleans the 
print heads as described 
on page 5-8.

If you need to replace an 
ink cartridge before the 
lights flash (because the 
ink is too old, for example) 
follow the instructions on 
page 5-7.

Leave the old cartridge 
installed until you are 
ready to replace it with a 
new one. Attempting to 
print without a cartridge 
installed can damage 
your printer.

Once your remove an ink 
cartridge, it becomes 
unusable and cannot be 
reinstalled.

ink cartridge clamp

Warning:
If ink gets on your hands, 
wash them thoroughly with 
soap and water. If ink gets 
into your eyes, flush them 
immediately with water.
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Installing the New Cartridge

Once you have removed the empty cartridge, you’re ready to 
install the new one. Follow these steps:

1. Remove the new ink cartridge from its packaging. 

2. Remove the yellow tape seal as shown:

3. Lower the ink cartridge into its holder with the label facing 
up and the arrow pointing to the back of the printer. The 
larger cartridge (color) goes on the right, the black ink 
cartridge on the left.

4. Press down the ink cartridge clamp until it locks in place.

Caution:
You must remove the 
yellow tape seal from the 
top of the cartridge; 
leaving the tape on will 
permanently damage it. 
Do not remove the clear 
seal from the bottom of 
the cartridge; ink will leak.

black cartridge color cartridge

Caution:
Don’t open the clamp or 
remove a cartridge 
except to replace it with 
a new one. Once you 
remove a cartridge, you 
can’t reuse it, even if it 
contains ink.
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5. If you need to replace the other ink cartridge, remove it as 
described in “Removing an Empty Ink Cartridge” on 
page 5-5. Then follow steps 1 through 4 in this section.

6. Press the R cleaning button and close the printer cover.

The printer moves the print heads and begins charging the 
ink delivery system. (Even if you don’t press the button, ink 
charging begins 60 seconds after you close the clamp.)

The Ppower light flashes and the printer makes various 
sounds. Charging takes about two minutes. When it’s 
finished, you can print again.

Replacing an Outdated Ink Cartridge

If an ink cartridge is more than six months old, you may need 
to replace it. How can you tell? You may notice that your 
printouts don’t look as good as they used to. If print quality 
doesn’t improve after cleaning and aligning the print heads, you 
can replace one or both cartridges.

Follow these steps to replace an ink cartridge before the B black 
or A color ink out light is flashing or on:

1. Make sure the printer is turned on and not printing.

2. Lower the output tray and raise the printer cover. 

3. Press the E load/eject button and hold it down for a few 
seconds until the print heads move to the left.

4. Pull up the ink cartridge clamp. The cartridge rises up from 
its holder. 

5. Lift the cartridge out of the printer and dispose of it 
carefully. 

6. Follow the steps in the previous section, “Installing the 
New Cartridge,” to install the new ink cartridge.

Caution:
Never turn off the printer 
while the P power light 
is flashing.

If however, the Ppower 
light is still flashing after 
10 minutes and the 
printer is not moving or 
making noise, you may 
turn off the printer.

Caution:
To avoid damaging the 
printer, never move the 
print heads by hand.

maintran.fm5  Page 7  Thursday, July 24, 1997  3:08 PM



Maintenance and Transportation

5-8

Aligning the Print Heads
If your printouts contain misaligned vertical lines, you may 
need to align the print heads. Follow these steps:

1. Make sure the printer is turned on and paper is loaded.

2. Access the Main printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment icon.

5. Follow the instructions on the screen to print a test page 
and select the correct alignment.

Caution:
Load paper that’s at least 
8.3 inches wide so ink 
doesn’t spray onto the 
platen.

Note:
Wait until your printer has 
finished printing before 
using this utility.

Do not use this utility with 
printers on a network.
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Cleaning the Printer
To keep your printer working at its best, you should clean it 
several times a year, following these steps:

1. Turn off the printer, unplug the power cord, and 
disconnect the printer cable.

2. Remove all the paper from the sheet feeder.

3. Clean the exterior of the printer with a soft, damp cloth. 
Keep the printer cover closed so water doesn’t get inside.

4. Clean ink out of the printer’s interior with a soft, damp 
cloth.

Caution:
Don’t touch the gears 
inside the printer.

Never use alcohol or 
thinner for cleaning; they 
can damage the printer 
components and case.

Don’t use a hard or 
abrasive brush.

Don’t get water on the 
printer components.

Don’t spray lubricants or 
oils inside the printer.
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Transporting the Printer
If you want to move your printer some distance, you need to 
prepare it for transportation and repack it in the original box. 
Follow these steps:

1. Turn on the printer and wait until the print heads lock in 
the far right position. Then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then 
disconnect the interface cable from the printer.

3. Remove any paper from the sheet feeder and remove the 
paper support.

4. Push in the output tray extensions and close the tray.

5. Repack the printer and attachments in the original box 
using the protective materials that came with it. See the 
Notice Sheet that was packed with the printer.

Be sure to keep the printer level as you transport it. If you 
notice a decline in print quality after transporting the printer, 
clean the print heads; if output is misaligned, align the print 
heads. See the instructions in this chapter.

Caution:
To avoid damage, 
always leave the ink 
cartridges installed when 
transporting the printer.
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As you use your printer, you may occasionally experience a 
paper jam or other problem. The first thing you should do is 
diagnose the problem, following the guidelines in this chapter. 
Then try the most likely solutions until the problem is fixed. 

This chapter tells you everything you need to know about the 
following:

◗ Diagnosing problems

◗ Improving print quality

◗ Solving printing problems

◗ Fixing paper jams and other paper problems

◗ Solving miscellaneous printout problems

Diagnosing Problems
Your printer includes a number of ways to help you diagnose 
problems:

◗ To identify the most common problems, check the lights 
on the printer’s control panel. See “What To Do When the 
Printer Lights Flash” on page 1-11.

◗ You can also use the Status Monitor utility to identify 
common problems. For instructions, see page 4-4 
(Windows 95) or page 4-7 (Macintosh).

Troubleshooting
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◗ To determine whether the problem is caused by the printer 
itself, run a printer operation check. See “Running a Printer 
Check” for instructions.

◗ For the latest information, check the EPSON Stylus 
COLOR 600 Help program and the ReadMe file in the 
EPSON program group or folder. 

◗ If none of the suggested solutions in this chapter solve your 
problem, contact EPSON as described under “Where to Get 
Help” in the Introduction.

Running a Printer Check

You can run a printer check to determine whether the problem 
comes from the printer itself or some other source. 

◗ If the results are satisfactory, the problem lies in software 
settings, the interface cable, or your computer.

◗ If the printer check does not print correctly, you have a 
problem with your printer. See the suggestions in this 
chapter for possible solutions.

Follow these steps to check the printer:

1. Make sure both the printer and computer are turned off.

2. Disconnect the interface cable from the printer.

3. Make sure paper is loaded in the printer.

4. Hold down the E load/eject button and press the Ppower 
button to turn on the printer. Then release both buttons.

Caution:
Use paper that’s at least 
8.2 inches wide. 
Otherwise the print head 
will spray ink directly onto 
the platen.
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The printer prints one page containing a nozzle check 
pattern and the printer’s ROM version. The following 
sample is in black and white, but the actual printout is in 
color.

W0186 02BB

5. After it prints the page, turn off the printer. Remember to 
reconnect the interface cable, then turn on the printer and 
your computer.

Improving Print Quality
You can often improve print quality by doing one of the 
following:

◗ Clean the print heads (see Chapter 5 for instructions).

◗ Use higher quality paper appropriate for your print job (see 
Chapter 3 for a list of EPSON papers).

◗ Match the Media Type setting in the printer software to 
the type of media you loaded in the printer (see Chapter 3 
for details).

◗ Turn off High Speed mode in the More Settings dialog 
box (see Chapter 2 for details).

◗ Make sure Economy mode is off in the printer driver.

◗ Replace the ink cartridges. (Check the status of the B black 
and A color ink out lights first. See Chapter 5 for 
instructions.)
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Here are some detailed solutions to specific print quality 
problems.

Printed image has horizontal banding

Vertical lines are misaligned or vertical banding appears

The printed image has incorrect or missing colors

Possible cause Solution

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the loaded paper or 
other media. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 and 3.

The printable side of the 
paper is face down.

Remove the paper and reload it with the printable side face up. 
See Chapter 3 for instructions.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ink cartridges are low 
on ink.

Check the B black and A color ink out lights to see which cartridge 
you may need to replace. See Chapter 5.

The MicroWeave option is 
not set.

Turn on MicroWeave in the advanced printer settings dialog box. 
See Chapter 2 for more information.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

High Speed mode is 
turned on.

Turn off High Speed mode if vertical lines are misaligned. See 
Chapter 2 for information.

The print heads are 
misaligned.

Run the Print Head Alignment utility. See Chapter 5 for 
instructions.

Possible cause Solution

The Ink option is set to 
Black.

Change the Ink setting to Color. See Chapter 1 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper or media 
you’re using. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 and 3.

The printable side of the 
paper is face down.

Remove the paper and reload it with the printable side face up. 
See Chapter 3 for instructions.
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The printed image is faint or has gaps

The Halftoning and Color 
Adjustment Mode 
options are set incorrectly 
for your document type.

Use the correct settings for the project you are printing, following 
the instructions in Chapter 2.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ICM (Windows 95) or 
ColorSync (Macintosh) 
settings are incorrect for 
your document.

Use the Automatic mode setting or choose a different Rendering 
Intent setting (Macintosh). See Chapter 2 for more information.

The ink cartridges are low 
on ink or one or more ink 
colors are empty.

Check the B black and A color ink out lights to see which cartridge 
you may need to replace. See Chapter 5 for instructions.

The colors displayed on 
your monitor don’t match 
the printed colors.

Because your monitor and printer use different technologies to 
represent colors, your printed colors cannot exactly match the 
colors you see on your monitor screen. Use the ICM (Windows 95) 
or ColorSync (Macintosh) settings. See Chapter 2 for more 
information.

The color settings in your 
application software need 
adjustment.

You may be able to adjust various color settings in your application 
software. See your software documentation for more information.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the loaded paper or 
other media. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 and 3.

The loaded paper is 
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side 
face up. See Chapter 3 for instructions.

The ink cartridges are low 
on ink.

Check the B black and A color ink out lights to see which cartridge 
you may need to replace. See Chapter 5 for instructions.

Possible cause Solution
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The printed image is blurry or smeared

Photographic images look grainy or rough

Possible cause Solution

The printer’s adjust lever is 
in the 0 position.

Set the adjust lever to the + position and try printing again. See 
Chapter 3 for instructions.

The paper is damp or the 
printable side is face down.

Remove the paper and reload a new stack with the printable side 
face up. See Chapter 3 for instructions.

You loaded special media 
without a support sheet.

Follow the special media loading instructions in Chapter 3 and on 
the paper packaging for media that require support sheets. Also try 
loading your media one sheet at a time.

You tried to print on 
cardboard or other 
non-recommended media.

Make sure your paper or media meets the specifications listed in 
the Appendix. If your printouts are still blurry after you change 
paper, clean the print heads as described in Chapter 5.

The Media Type setting 
does not match the loaded 
paper.

Make sure the Media Type setting matches the media you loaded. 
Then the printer software can automatically select other settings 
for the best quality. See Chapter 3 for information.

The sheets entering the 
output tray are smearing 
the ink on ejected pages.

Remove each sheet from the output tray as soon as it is printed to 
prevent smearing, especially if you use transparencies. 

Ink has leaked inside the 
printer.

Clean carefully inside the printer to remove spilled ink. See 
Chapter 5 for instructions.

The color ink cartridge is 
empty.

Replace the color ink cartridge following the instructions in 
Chapter 5 or choose Black ink in your printer software.

You’re using the High 
Speed and MicroWeave 
settings with a misaligned 
print head.

Turn off High Speed following the instructions in Chapter 2. Run 
the Print head Alignment utility following the instructions in 
Chapter 5.

Possible cause Solution

The print heads are 
misaligned.

Run the Print Head Alignment utility. See Chapter 5 for 
instructions.

The resolution of your 
image may be too low.

Increase the image resolution using your image-editing software, 
or decrease the size of the image.
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Color documents print in black and white

Solving Printing Problems
If the printer won’t print, first check that:

◗ The printer is turned on and the Ppower light is on.

◗ Paper is loaded in the printer.

◗ The printer is plugged into a working electrical outlet that’s 
not controlled by a switch or timer.

◗ The interface cable is securely connected to the printer and 
computer and both are turned on. 

If you still can’t print, check the following solutions.

All lights are off

Only the Ppower light is on, but nothing prints

Possible cause Solution

Your printer is not selected 
in your application.

Select your printer and port in your software application.

Color printing is not 
selected.

Select color printing in your application and the printer driver.

Possible cause Solution

The printer is not receiving 
power.

Try these solutions:
◗ Make sure the printer is turned on.
◗ Turn off the power and plug in the power cord securely.
◗ Make sure the outlet is not controlled by a switch or timer and 

is operable.

Possible cause Solution

The interface cable is not 
connected securely.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets the printer’s specifications. Try 
printing again.

The printer has an internal 
problem.

Turn off the printer and computer, disconnect the interface cable, 
and run a printer check as described on page 6-2.

trouble.fm5  Page 7  Thursday, July 24, 1997  3:10 PM



Troubleshooting

6-8

The S paper out light is flashing or on

A B black or A color ink out light is flashing or on

Your printer or application 
software is installed 
incorrectly.

If the printer check prints correctly, check your printer and 
application software for correct installation. If you’re printing on a 
Windows 95 network, you may need to set up your printer for 
network printing, as described in Chapter 4.

Your computer doesn’t 
have enough memory to 
handle the data in the file 
you are printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

Printing is stalled in Spool 
Manager (Windows).

Delete the stalled print jobs in Spool Manager and resume printing; 
see Chapter 4 for instructions.

Printing is stalled in 
Monitor2 (Macintosh).

Open the Extensions folder, EPSON folder, and Spool folder. Then 
delete any queued files.

The print heads are clogged 
or the ink cartridges are too 
old.

If the printer sounds like it’s trying to print but doesn’t feed paper, 
clean the print heads; see Chapter 5 for instructions.

If cleaning doesn’t help, replace the cartridges. For information on 
cartridge life and replacement instructions, see Chapter 5.

Possible cause Solution

If flashing, paper is 
jammed.

Remove the paper and follow the guidelines for preventing jams 
on page 6-13.

If on, paper is not loaded or 
is loaded incorrectly.

Load paper or remove the stack and reload it as described in the 
Setup Guide or Chapter 3. Then press the E load/eject button to 
turn off the light and resume printing.

Possible cause Solution

If flashing, the ink supply is 
getting low.

You need to replace the indicated ink cartridge soon. Make sure 
you have a new cartridge, then see Chapter 5 for instructions.

If on, the ink cartridge is 
empty.

You must replace the indicated ink cartridge; see Chapter 5 for 
instructions.

Possible cause Solution
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The S paper and Ppower lights are flashing

All the lights are flashing

The printer has finished charging the ink cartridge, but the Ppower light is still 

flashing

The printer software installed with Windows 3.1 does not work correctly after you 

upgrade to Windows 95

Possible cause Solution

A carriage error has 
occurred.

Remove any paper in the printer. Press the E load/eject button for 
about 30 seconds. Then press it again. Turn the printer off, wait a 
few seconds, and then turn it on and try printing again. If the error 
is not cleared, contact EPSON as described in the Introduction.

Possible cause Solution

You haven’t removed all 
the packing material from 
the printer.

Remove the packing material, following the instructions on the 
Notice Sheet in the box. 

An internal error may have 
occurred. 

Turn off your printer, wait a few seconds, and turn it on again. If 
the lights still flash or stay on, contact EPSON as described in the 
Introduction.

Possible cause Solution

The ink cartridge clamp isn’t 
locked down.

Press down on the clamp to lock it into place.

Packing material remains in 
the printer.

Remove the packing material, following the instructions on the 
Notice Sheet in the box. 

The printer needs to 
initialize.

If the printer is not moving or making noise, but the light is still 
flashing for more than 10 minutes, turn the printer off. If the light 
is still flashing when you turn it back on, contact EPSON as 
described in the Introduction.

Possible cause Solution

Your printer software is not 
set up correctly for 
Windows 95.

Reinstall the printer software after installing Windows 95, as 
described in the Setup Guide.
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After you install your printing software, you see the Windows 95 New Hardware 

Found window

You see a spooling error message (Windows)

In Windows 95, the Status Monitor box does not appear with the Despooler

You see a memory error message (Macintosh)

Possible cause Solution

An operating system error 
has occurred.

Click Do not install a driver, and then click OK.

Possible cause Solution

Spooling error messages or 
very slow printing may be 
caused by temporary files.

Change the Spool Manager default directory, following the 
instructions in Chapter 4.

Your hard drive is too full. Delete unnecessary files to make room on the drive.

Your computer doesn’t 
have enough memory for 
the file you’re printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

Possible cause Solution

The Windows Print 
Manager is interfering with 
the Status Monitor.

Make sure Use Print Manager for this port is not checked in the 
Spool Manager Queue setup. Then check your bidirectional spool 
settings. See Chapter 4 for instructions.

Possible cause Solution

You may need to increase 
the memory allocation for 
your application, EPSON 
Monitor2, or both.

Choose Get Info from the File menu when your application is 
active and increase the memory requirements. See Chapter 4 for 
more information. Or turn off background printing (you won’t be 
able to use Monitor2).
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A portion of your image doesn’t print (Macintosh)

Printing is too slow

Your printer switches to the modem port or won’t confirm on the printer port 

(Macintosh)

Possible cause Solution

Your system doesn’t have 
enough available memory.

Close any other applications you are running or turn off 
background printing.

You may need to increase 
the memory allocation for 
your application, EPSON 
Monitor2, or both.

Choose Get Info from the File menu when your application is 
active and increase the memory requirements. See Chapter 4 for 
more information. Or turn off background printing (you won’t be 
able to use Monitor2).

Possible cause Solution

Your printer software 
options are set incorrectly.

For faster printing, try the following:
◗ Set Print Quality to Economy.
◗ Turn MicroWeave off.
◗ Turn High Speed on.
◗ Choose Black ink.
◗ Choose No Halftoning.
See Chapters 1 and 2 for more information.

Your system doesn’t have 
enough resources.

◗ Clear space on your hard disk drive or run a defragmentation 
utility.

◗ Don’t run too many applications at the same time.
◗ Turn off virtual memory.
◗ Increase your system’s memory (RAM).

You’re using background 
printing on a Macintosh.

Choose Get Info from the File menu when your application is 
active and increase the memory requirements. See Chapter 4 for 
more information. Or turn off background printing (you won’t be 
able to use Monitor2).

Your port settings are 
incorrect in Windows 95.

Change your default spool directory and disable port settings as 
described in Chapter 4.

Possible cause Solution

Your system has extension 
conflicts.

Make sure AppleTalk® is inactive. In the Extensions Manager, 
disable the AppleShare, FileShare, and PrinterShare extensions. 
Set your printer and any unused printers to the printer port. Then 
restart your system.

You’re using an AppleTalk 
cable.

Make sure you’re using a standard Apple System Peripheral-8 
cable.
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The “Sorry, EPSON Stylus COLOR cannot be used” message appears (Macintosh)

Your printer icon doesn’t appear in the Chooser (Macintosh)

Fixing Paper Problems
You can avoid most paper handling problems by doing the 
following:

◗ Use smooth, high-quality media designed for ink jet 
printers that meets the media specifications in the 
Appendix.

◗ Follow all loading and handling instructions included with 
the media.

◗ Load the media with the printable side face up, as described 
in the Setup Guide or Chapter 3.

If you have problems with paper feeding, paper jams, or ejected 
paper, check here for solutions.

Possible cause Solution

The printer driver has been 
corrupted.

Remove and reinstall the driver: 

1. From the printer software CD-ROM or floppy disk, click 
Installer, click Continue, and select Custom Remove from the 
pop-up list that displays “Easy Install.” 

2. Select EPSON Stylus Series Printer Driver, and click 
Remove. Click Continue, if necessary, and click Restart. 

3. See the Setup Guide for instructions on installing the printer 
driver. 

4. In the Extensions Manager, make sure Quick Draw GX is not 
loaded. 

5. Make sure EPSON Monitor2 and EPSON Stylus Color(EX) are 
enabled, then restart your Macintosh.

Possible cause Solution

Your system has extension 
conflicts.

In the Extensions Manager, disable Quick Draw GX. Make sure 
EPSON Monitor2 and EPSON Stylus Color are enabled, then 
restart your Macintosh.
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Paper doesn’t feed

Multiple pages feed at the same time

Paper jams inside the printer

Try this Then do this

Remove the stack of paper 
from the sheet feeder.

Check that the paper:
◗ Isn’t curled or creased.
◗ Isn’t too old (see Chapter 3 or your paper packaging for more 

information).
◗ Isn’t loaded above the arrow on the left edge guide.
◗ Isn’t jammed inside the printer. (If the S paper out light is 

flashing, paper is jammed.)
Then reload the paper as described in Chapter 3, making sure the 
left edge guide is adjusted to fit the paper’s width.

Try this Then do this

Remove the stack of paper. ◗ Make sure the paper isn’t too thin (see the paper specifications 
in the Appendix).

◗ Fan the edges of the stack of paper to separate the sheets.
◗ Reload the paper as described in the Setup Guide and 

Chapter 3.
◗ If more copies of a page or document are printing than you 

expected, check the Copies settings in both the printer 
settings dialog box and your application program. See 
Chapter 1 for information.

Try this Then do this

Turn off your printer, open 
the cover, and remove all 
the paper that’s inside, 
including any little pieces 
that may have torn off. 

Reload the paper as described in the Setup Guide and Chapter 3.

If your paper jams frequently, make sure you:
◗ Use smooth, high-quality paper, loaded printable side up.
◗ Fan the stack and then even the edges before loading it.
◗ Don’t load paper above the arrow mark on the left edge guide.
◗ Adjust the left edge guide to fit the width of your paper.
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Paper doesn’t eject fully or is wrinkled

Solving Miscellaneous Printout 
Problems
If your printout results are not what you expected, try these 
solutions.

Characters are incorrect or garbled

.

Possible cause Solution

If the paper doesn’t eject 
fully, you may have set the 
wrong paper size.

Press the E load/eject button to eject the paper. Then make sure 
you select the correct paper size in your application or printer 
software. (See the paper specifications in the Appendix for the 
paper sizes you can print with.)

If it’s wrinkled when it 
comes out, the paper may 
be damp or too thin.

See the paper specifications in the Appendix for paper thicknesses 
you can print with, as well as environmental requirements for 
storage.

Possible cause Solution

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Open the Chooser and select your printer. See the Setup Guide for 
instructions.

Printing is stalled in Spool 
Manager (Windows).

Delete the stalled print jobs in Spool Manager following the 
instructions in Chapter 4. Then try printing again.

If you’re using background 
printing on a Macintosh, 
spooled data may be 
corrupted.

Open the Extensions folder, EPSON folder, and Spool folder. Then 
delete any queued files. Increase the memory requirements for 
EPSON Monitor2.

The interface cable is not 
securely connected.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets the printer’s specifications.

Your video driver may be 
conflicting with the 
EPSON driver 
(Windows 3.1 only).

Try using a standard VGA video driver (see your computer or video 
card documentation for instructions on changing video drivers). If 
your printout is correct, your video driver is interfering with the 
printer driver. Contact your computer or video card manufacturer to 
see if an updated driver is available.
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The margins are incorrect

The image is inverted as if viewed in a mirror

The printer prints blank pages

Possible cause Solution

Margins are set incorrectly 
in your software 
application.

Check your software documentation for instructions on selecting 
the correct margins for your paper size.

Make sure the margins are within the printable area of the page. 
See the Appendix for more information.

Paper settings in the printer 
software are incorrect for 
your paper size.

Select the correct paper settings for your paper size. See 
Chapter 1 for more information.

Possible cause Solution

You used a Flip Horizontal 
option in your application 
software or the printer 
software.

Turn off the Flip Horizontal or mirror setting in your application 
software or the printer software. See Chapter 2 for information.

Possible cause Solution

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Open the Chooser and select your printer. See the Setup Guide for 
instructions.

Paper settings in the printer 
software are incorrect for 
your paper size.

Select the correct paper settings for your paper size. See 
Chapter 1 for more information.

The print head nozzles are 
clogged.

Clean the print heads following the instructions in Chapter 5.
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A
Printing

Printing method On-demand ink jet

Nozzle configuration Monochrome (black) 64 nozzles (32 × 2 staggered)
Color (cyan, magenta, yellow) 32 nozzles × 3

Printable columns and 
printing speeds

cps = characters per second 

Resolution Maximum 1440 dpi × 720 dpi

Print direction Bidirectional with logic seeking for text and graphics. (Auto print 
direction can be set in the default-setting mode.)

Control code ESC/P 2 and expanded raster graphics code

Line spacing 1/6 inch, 1/8 inch, or programmable in 1/360-inch increments

Paper feed speed 66.6 milliseconds per 1/6-inch line 

Input buffer 32KB

Specifications

Character mode
Character pitch 

(characters per inch) Printing column Draft speed

LQ printing 

speed

10 80 400 cps 200 cps

12 96 480 cps 240 cps

15 120 600 cps 300 cps

17 (10 condensed) 137 684 cps 342 cps

20 (12 condensed) 160 800 cps 400 cps
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Fonts

Select other font/pitch combinations using ESC/P 2 commands.
See the Command List on page A-9.

Each font has four variations: normal, bold, italic, and bold italic.

Note: 
The printer always uses the fonts you selected with your software application. You need to use the 
printer’s internal fonts only if your application doesn’t allow you to select fonts.

Character tables These character tables are selected with the default setting mode (see 
page A-8 for instructions) or by using software commands.

◗ PC437 (U.S./Standard Europe)

◗ PC850 (Multilingual)

◗ PC860 (Portuguese) 

◗ PC861 (Icelandic)

◗ PC863 (Canadian-French)

◗ PC865 (Nordic)

◗ Abicomp

◗ BRASCII

◗ Roman 8

◗ ISO Latin 1

◗ Italic

Character sets 14 international character sets and 1 legal character set

Bitmap fonts
Font 10 cpi 12 cpi 15 cpi Proportional

EPSON Roman x x x x

EPSON Sans Serif x x x x

EPSON Courier x x x

EPSON Prestige x x x

EPSON Script x x x

Scalable fonts

Font

Minimum 

point size

Maximum 

point size Increments

EPSON Roman 8 32 2

EPSON Sans Serif 8 32 2

EPSON Roman T 8 32 2

EPSON Sans Serif H 8 32 2
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Paper 

Note: 
Since the quality of any particular brand or type of paper may be changed by the manufacturer at 
any time, EPSON cannot attest to the quality of any non-EPSON brand or type of paper. Always 
test samples of paper stock before purchasing large quantities or printing large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you 
encounter problems, switch to a higher grade of paper.

Do not load curled or folded paper.

Ink jet paper, envelopes, glossy film, glossy paper, and transparencies are usable only under 
normal conditions:

Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

EPSON Photo Quality Glossy Paper and Photo Quality Self Adhesive Sheets should be stored 
under the following conditions:

Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Paper type Size Paper types Thickness Weight

Single sheets Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)
Legal (8.5 × 14 inches) 
Statement (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)

Plain bond paper and 
special ink jet papers 
distributed by EPSON

0.003 to 0.004 inch 
(0.08 to 0.11 mm) 

17 to 24 lb 
(64 to 90 g/m2)

Transparencies, 
Glossy film, 
Glossy paper, 
Photo paper

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy 
film only)
4 × 6 inches (102 × 152 mm 
photo paper only)

Transparencies, 
glossy paper, glossy 
film, and photo paper 
distributed by EPSON

Glossy film and 
transparencies: 
0.005 to 0.006 inch 
(0.13 to 0.15 mm)
glossy paper:
0.0066 to 0.0070 inch 
(0.17 to 0.18 mm)

Self adhesive 
sheet

A4 (210 × 297 mm) Self adhesive sheets 
distributed by EPSON

Envelopes No. 10 9.5 × 4.1 inches 
(240 × 104 mm) 

DL 8.7 × 4.3 inches 
(220 × 110 mm) 

C6 4.4 × 6.4 inches 
(114 × 162 mm)

Plain bond paper or 
air mail paper

0.006 to 0.017 inch 
(0.16 to 0.43 mm)

12 to 20 lb 
(45 to 75 g/m2)

Index cards A6 (105 × 148 mm)
10 × 8 inches (254 × 203 mm)

Ink jet cards 
distributed by EPSON

0.0091 inch 
(0.23 mm)

50.7 lb 
(188 g/m2)
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Printable area

A: The minimum top margin is 0.12 inch (3.0 mm).

When loading multiple sheets of EPSON Photo Quality Glossy Film, the minimum top margin is 
1.2 inches (30 mm).

B–L: The minimum left margin is 0.12 inch (3.0 mm).

B–R: The minimum right margin for single sheet paper is 0.12 inch (3.0 mm) except for letter and legal size 
paper. The minimum right margin for letter and legal size paper is 0.35 inch (9.0 mm).

The minimum right margin for envelopes is as follows:
0.28 inch (7.0 mm) for DL envelopes.
1.10 inches (28.0 mm) for No. 10 envelopes.
0.12 inch (3.0 mm) for C6 envelopes.

C: The minimum bottom margin is 0.54 inch (14.0 mm)

A: The maximum top margin is 0.67 inch (17.0 mm).

B–L, 
B–R: The maximum left and right margin is 0.24 inch (6.1 mm).

C: The maximum bottom margin is 0.24 inch (6.1 mm).

Note:
Always load paper into the sheet feeder short edge first. However, envelopes should be loaded 
long edge first.

A

B-L

B-R

C

A

B-R

C

B-L

EnvelopeSingle sheet

A

B-L, B-R

C

EPSON Photo Paper 
(dotted lines indicate 
perforations)
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Ink Cartridge

* The print capacity may vary, depending on how often you use the print head cleaning function.

** It thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution:
To ensure good results, use genuine EPSON ink cartridges. Other products may cause damage 
to your printer not covered by EPSON’s warranty.

Don’t use an ink cartridge if the date on the package has expired.

Mechanical
Paper feed method Friction

Paper path Sheet feeder, rear entry

Sheet feeder capacity 100 sheets at 17 lb (64 g/m2) paper

Total print volume 75,000 pages (A4, Text)

Dimensions

Storage Width: 16.9 inches (429 mm) 
Depth: 10.8 inches (275 mm) 
Height: 6.6 inches (168 mm)

Printing Width: 16.9 inches (429 mm) 
Depth: 24.1 inches (613 mm) 

27.4 inches (695 mm) when printing transparencies
Height: 12.2 inches (309 mm)

7.7 inches (196 mm) when printing transparencies

Weight 11.5 lb (5.2 kg) without the ink cartridges

Specification Black ink cartridge (S020093) Color ink cartridge (S020089)

Color(s) Black Cyan, Magenta, and Yellow

Print capacity* 540 pages/A4 (ISO/IEC 10561 Letter Pattern 
at 360 dpi)

300 pages (A4, 360 dpi, 5% duty each color)

Cartridge life 2 years from production date (if unopened)
(within 6 months after opening package, at 77 °F (25 °C))

Storage 
temperature

–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit 
temperature

–22 to 140 °F (–30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing 
temperature**

3.2 °F (–16 °C) –0.4 °F (–18 °C)

Dimensions 0.7 (W) × 2.1 (D) × 1.5 (H) inches
19.8 (W) × 52.7 (D) × 38.5 (H) mm

1.7 (W) × 2.1 (D) × 1.5 (H) inches
42.9 (W) × 52.7 (D) × 38.5 (H) mm
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Electrical

Note: 

Check the label on the back of the printer for the voltage of your printer.

Environmental
Temperature Operation: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 140 °F (–20 to 60 °C), stored in shipping container 
1 month at 104 °F (40 °C) 
120 hours at 140 °F (60 °C)

Humidity Operation: 20 to 80% RH
Storage: 5 to 85% RH (stored in shipping container, without 
condensation)

Safety Approvals
Safety standards UL 1950 with D3, CSA C22.2 No.950 with D3

EMC FCC part 15 subpart B class B, CSA C108.8 class B

Interface Your printer is equipped with an 8-bit parallel interface and a serial 
interface.

Parallel interface The built-in parallel interface has the following characteristics:

Forward channel Data format: 8-bit parallel, IEEE-1284 compatibility mode

Synchronization: STROBE pulse

Handshake timing: BUSY and ACKNLG signals

Signal level: TTL compatible

Connector: 57-30360 Amphenol connector or equivalent

Reverse channel Transmission mode: IEEE-1284 Nibble mode

Adaptable connector: 57-30360 Amphenol Connector or equivalent

Synchronization: Refer to the IEEE-1284 specification

Specification 120V Model 220−240V Model

Input voltage range 103.5 to 132V 198 to 264V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4A 0.2A

Power consumption Approx. 15W (ISO/IEC 10561 Letter Pattern)
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Handshaking: Refer to the IEEE-1284 specification

Signal level: IEEE-1284 Level 1 device

Data transmission timing: Refer to the IEEE-1284 specification

Serial interface The printer’s built-in serial interface is based on the RS-423 standard. 
This interface has the following characteristics: 

Standard: Based on RS-423

Synchronization: Synchronous

Bit rate: Approx. 900 Kbps

Handshaking: X-ON/X-OFF DTR protocol

Word format: 
Data bit: 8 bits
Parity bit: None
Start bit: 1 bit
Stop bit: 1 bit

Connector: 8-pin mini-circular connector

Recommended cable: Apple System Peripheral-8 cable (Part number 
M0197)

Initialization The printer can be initialized (returned to a fixed set of conditions) in     
these ways:

Hardware 
initialization

When the printer is turned on, the printer mechanism is initialized, 
the input and print buffers are cleared, and all settings return to their 
default values. However, the printer mechanism is not initialized if the 
printer is turned on within 10 seconds after being turned off. In this 
case, the printer caps the print head, and ejects any paper in the paper 
path.

Software 
initialization

Software initialization clears the print buffer and returns all settings to 
their default values, as shown below.

Hardware 
initialization

∗ The printer is turned on.
∗ The printer receives an INIT signal from the parallel
   interface.

Software 
initialization

∗ Software sends the ESC @ (initialize the printer) command.
   The last panel settings are kept.
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Default Settings
The table below shows the default settings that take effect when the 
printer is initialized. To change these settings, follow the instructions 
in “Built-in Fonts and Character Tables.”

Built-in Fonts and Character Tables
Your printer has eight built-in fonts and eleven character tables that 
you can select using the printer’s default setting mode as described 
below. The setting you choose takes effect each time you turn on the 
printer. Available fonts and character tables are listed on page A-2.

Note: 

The font and character table selections you make with your software override the settings you 
make using the default setting mode. For best results, use your software to make these settings.

To change the default font or character table, follow these steps:

1. Make sure the printer is turned off and paper is loaded in the 
sheet feeder. (Use paper at least 8.3 inches wide. Otherwise the 
print heads will spray ink directly onto the platen.)

2. Hold down the R cleaning button and turn on the printer.

The printer loads a sheet of paper and prints a brief summary and 
instructions.

3. Follow the instructions on the sheet and press the R cleaning 
button until the control panel lights indicate the language of your 
choice.

Item Default setting

Top-of-form position Current paper position

Page length Single sheets: 22 inches

Left and right margins Cancelled

Line spacing 1/6-inch line spacing

Character pitch Last font selected using default setting mode

Vertical tab position Cleared

Horizontal tab positions Every eight characters

Font selection Last font selected using default setting mode

Special printing effects Cancelled (except condensed and economy 
printing)

User-defined character set Hardware/control panel initialization: cleared
Software initialization: deselected only
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4. Press the E load/eject button to print the default font and 
character table and the next page of instructions.

The instruction sheet lists all of the fonts and character tables you 
can select. 

5. Select the font and character table you want to use. 

6. Exit the default setting mode by turning off the printer.

If you want to check the current default font and character table, enter 
the default setting mode again and print the current settings, which 
are indicated by arrows. 

Note: 

You may exit default setting mode any time by turning off the printer. Any changes you made 
remain in effect until you change them again.

Command List This section lists the available printer commands by topic. Your 
printer works with the following commands.

ESC/P 2 control codes Selecting EPSON ESC/P 2 printer in your software allows you to use 
the most advanced font and graphics handling available. See the 
ESC/P  Reference Manual for details.

General operation ESC @, ESC U, ESC EM

Paper feeding CR, FF, LF, ESC 0, ESC 2, ESC 3, ESC +

Page format ESC ( C, ESC C, ESC C0, ESC Q, ESC l, ESC ( c, ESC N, ESC O

Print position 
motion

ESC $, ESC \, ESC ( V, ESC ( v, ESC D, HT, ESC B, VT, ESC J

Font selection ESC k, ESC x, ESC X, ESC P, ESC M, ESC g, ESC p, ESC 4, ESC 5, 
ESC E, ESC F, ESC !

Font enhancement ESC W, DC4, SO, DC2, SI, ESC w, ESC G, ESC H, ESC T, ESC S, 
ESC -, ESC ( -, ESC q

Spacing ESC Space, ESC c, ESC ( U

Character handling ESC t, ESC ( t, ESC R, ESC %, ESC &, ESC :, ESC 6, ESC 7, 
ESC ( ^ 

Bit image ESC *

Graphics ESC ( G, ESC ., ESC ( i, ESC ( e, ESC ( \, ESC ( s

Color ESC r, ESC ( r

Printing mode ESC ( K
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Glossary

banding The horizontal lines that sometimes appear when printing 
graphics. See also MicroWeave.

buffer The portion of the printer’s memory used to store data before 
printing it.

character table A collection of letters, numbers, and symbols that provides you 
with the characters used in a particular language.

characters per inch (cpi) A measure of the size of text characters, sometimes referred to as 
pitch.

CMYK Cyan (blue-green), magenta, yellow, and black. These colored 
inks are used to create the subtractive system array of printed 
colors.

ColorSync Macintosh software that is designed to help you get WYSIWIG 
(what you see is what you get) output. This software prints 
colors as you see them on your screen.

default A value or setting that takes effect when the equipment is 
turned on, reset, or initialized.

dithering A halftoning method in which dots are arranged in an orderly 
pattern. Dithering works best for printing images with solid 
colors, such as charts and graphs. See also halftoning.

dpi Dots per inch. The dpi measures the resolution. See also 
resolution.

driver A software program that sends instructions to a computer 
device to tell it what to do. For example, your printer driver 
accepts print data from your word processing application and 
sends instructions to the printer on how to print this data.
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Error Diffusion This halftoning setting smooths out edges by randomly placing 
dots of varying colors. This has the opposite effect of the Finest 
Detail setting.

ESC/P Abbreviation for Epson Standard Code for Printers. This 
system of commands gives you control of your printer from 
your computer. It is standard for all EPSON printers and 
supported by most application programs for personal 
computers.

ESC/P 2 The enhanced version of the ESC/P printer command 
language. Commands in this language produce laser-like 
features, such as scalable fonts and enhanced graphics printing.

Finest Detail This printer driver setting automatically makes your printed 
images sharper and clearer. This has the opposite effect of the 
Error Diffusion setting. Be aware that this may increase the 
time required for printing.

font A style of type designated by a name.

grayscale A scale of shades of gray from black to white. Grayscale is used 
to represent colors when printing with black ink only.

halftoning A method of using dot patterns to represent an image. 
Halftoning makes it possible to produce varying shades of gray 
using only black dots, or a nearly infinite array of colors using 
only a few colors of dots.

initialization Returns the printer to its defaults (fixed set of conditions). This 
happens every time you turn on or reset the printer.

ink jet A method of printing in which each letter or symbol is formed 
by precisely spraying ink onto paper.

interface The connection between the computer and a peripheral such as 
a printer. Some printers have two interfaces, parallel and serial. 
A parallel interface transmits data one byte, or eight bits, at a 
time. A serial interface transmits data one bit at a time.

ips Inches per second. This scale is used to measure the printing 
speed.
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media Materials upon which data is printed, such as envelopes, plain 
paper, special paper, and transparencies.

MicroWeave Printing technology that produces images in fine increments to 
reduce the possibility of banding. See also banding.

monochrome This means printing with only one color of ink, which is 
generally black ink.

parallel interface See interface.

print queue Print jobs that are sent to the printer while it is busy are stored 
in a waiting line, or print queue, until they can be printed.

print server The computer connected to the printer. It receives the jobs and 
then distributes them to the assigned printer. It also holds extra 
print jobs while the printer is busy. See also print queue.

printable area The area of a page on which the printer can print. It is smaller 
than the physical size of the page due to margins. 

printer driver See driver.

proportional printing Printing in which the width of the character varies from 
character to character. For example, a capital W receives much 
more space than a lowercase i. The result looks more like a 
typeset book than a typewritten draft.

reset To return a printer to its defaults either by sending a command, 
an INIT signal or by turning the printer off and then back on.

resolution The number of dots per inch used to represent an image.

RGB Red, green, and blue. These colors, in phosphors irradiated by 
the computer monitor’s electron gun, are used to create the 
additive array of screen colors.

scalable fonts Fonts that can be enlarged or reduced. Non-scalable fonts are 
called bitmap fonts and can’t change in size.

screen pattern This feature prints shaded areas as they appear on screen, 
instead of printing them as halftones.

gloss.fm5  Page 3  Thursday, July 24, 1997  3:13 PM



Glossary

G-4

serial interface See interface.

spool The process by which the printer driver converts the print data 
into codes that your printer understands. This data is then sent 
to the printer directly or to the print server.

Spool Manager An EPSON software program that converts print data into 
codes that your printer understands. See also spool.

Status Monitor An EPSON software program that displays the printer’s status, 
such as paper out or the amount of ink remaining before 
printing.

subtractive colors Colors produced by pigments that absorb some colors of light 
and reflect others. See also CMYK.
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Index

A Adjust lever, 3-9
Advanced mode and halftoning, 

2-6
Advanced mode, selecting, 

2-1 to 2-3
Advanced settings

custom, 2-4 to 2-12
predefined, 2-1 to 2-3

Aligning print heads, 5-8, 6-4
Automatic mode, 1-3, 1-8, 3-3

B Background printing, Macintosh, 
4-6

Banding, 6-4
Banners

loading paper, 3-9 to 3-10
printing from Macintosh, 

3-12 to 3-13
printing from Windows, 

3-10 to 3-12
Blank pages, 6-15
Blurry printouts, 6-6
Brightness setting, 2-8
Built-in fonts, A-8

C Cards, see Photo Quality Ink Jet 
Cards

Character tables, A-8
Characters, garbled, 6-14
Cleaning

print heads, 5-1 to 5-3
printer, 5-9
sheets, special media, 3-4

Color Adjustment modes, 2-8
Color problems, 6-4
Colorimetric setting, 2-10
ColorSync, 2-3, 2-9 to 2-10
CompuServe, 5
Contrast setting, 2-8
Control codes, A-1, A-9
Control panel

buttons, 1-12
lights, 1-11
using, 1-11 to 1-12, 6-1 to 6-2, 

6-7 to 6-9
Copies setting, 1-4
Custom paper size, 3-9, 3-11, 3-13
Custom settings

changing, 2-12
color, 2-7 to 2-9
deleting, 2-12
print quality, 2-4 to 2-6
project types, 2-3
refining, 2-12
saving, 2-11
special effects, 2-4 to 2-6

Cyan setting, 2-8

D Default printer options, setting, 
1-4 to 1-5

Deleting print job, 4-3
Despooler, 1-6, 4-5
Dithering, 2-6
DOS, printing from, 1-9
Draft printing, 2-3
Driver, help, 1-12 to 1-13
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E Economy setting, 2-3
Electrical specifications, A-6
ENERGY STAR, 6 to 7
Energy-saving tips, 7
Envelopes

printing, 3-8
printing on, 3-2
specifications, A-3, A-4

Environmental specifications, A-6
EPSON

Answers, 2
Customer Care Centers, 5
Electronic support services, 

5 to 6
help, 5 to 6
media, 1-10, 3-1 to 3-9
World Wide Web site, 5

ESC/P 2, 1-9, A-9

F Faint printouts, 6-5, 6-6
Film, see Photo Quality Glossy 

Film
Flip Horizontal setting, 2-6, 3-3, 

6-15
Fonts, A-2
Forms, printing, 3-4
FTP, 5

G Glossy media
choosing, 1-10
printing on, 3-5
specifications, A-3

H Halftoning setting, 2-5, 2-6
Head Cleaning utility, 5-2
Help, EPSON, 5 to 6
Help, online, 1-12 to 1-13
High quality glossy paper, see 

Photo Quality Glossy Film

High Quality Ink Jet Paper
choosing, 1-10
printing on, 3-2, 3-4
specifications, A-3

Horizontal banding, 6-4
Host system, network setup, 4-10

I ICM (Image Color Matching), 2-3, 
2-7 to 2-9

Index cards, see Photo Quality Ink 
Jet Cards

Initialization, A-7
Ink cartridge

replacing, 5-4 to 5-7
specifications, A-5

Ink jet cards
choosing, 1-10
printing on, 3-2, 3-7
specifications, A-3

Ink jet paper
choosing, 1-10
printing on, 3-2, 3-4
specifications, A-3

Ink jet transparencies
choosing, 1-10
printing on, 3-3
specifications, A-3

Ink setting, 2-5
Ink, monitoring level, 1-6, 4-5, 4-8
Interface specifications

parallel, A-6
serial, A-7

Internet, 5
Iron-On Transfer Paper

choosing, 1-10
printing on, 2-6, 3-3, 3-8

J Jammed paper, 1-11, 6-13
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L Labels
printing on, 3-2
specifications, A-3

Legal-size paper, 3-4
Letterhead, 3-4
Lever, adjust, 3-9
Lights, using, 1-11, 6-1, 6-7 to 6-9

M Macintosh
interface specifications, A-7
managing print jobs from, 

4-6 to 4-9
Monitor2, 4-6
printing from, 1-7 to 1-8
problems, 6-8, 6-10 to 6-12

Magenta setting, 2-8
Maintaining printer, 5-1 to 5-9
Managing print jobs

Macintosh, 4-6 to 4-9
Windows, 4-1 to 4-5

Margins
problems, 6-15
specifications, A-4
with multiple sheets, 3-5

Mechanical specifications, A-5
Media Type setting, 1-3, 2-5, 3-2
Messenger service, Windows NT, 

4-5
MicroWeave setting, 2-6
Mirror images, 2-6, 3-3
Monitor2, 4-6, 6-8
Moving printer, 5-10

N Network
path, 4-11 to 4-12
printing, 4-9 to 4-12

Nozzle Check
pattern, 5-4, 6-3
utility, 5-2 to 5-4

O Online driver help, 1-12 to 1-13
Orientation setting, 1-4

P Paper
adjust lever, 3-9
handling problems, 

6-12 to 6-14
jams, 1-11, 6-13
legal, 3-4
letterhead, 3-4
loading guidelines, 3-2 to 3-9
menu, 1-4
specifications, A-3 to A-4
support, 3-5
thickness lever, see Adjust lever

Paper size, custom, 3-9
Perceptual setting, 2-10
Perfect Picture Software Suite, 2, 3
Photo Paper, EPSON

choosing, 1-10
printing on, 3-2, 3-6 to 3-7
specifications, A-3

Photo Quality Glossy Film
choosing, 1-10
printing on, 3-3, 3-5
specifications, A-3

Photo Quality Glossy Paper
choosing, 1-10
printing on, 3-2, 3-5
specifications, A-3

Photo Quality Ink Jet Cards
choosing, 1-10
printing on, 3-2, 3-7
specifications, A-3

Photo Quality Ink Jet Paper
choosing, 1-10
printing on, 3-2, 3-4
specifications, A-3

Photo Quality Self Adhesive Sheets
choosing, 1-10
printing on, 3-2
specifications, A-3

Photo setting, 2-3
PhotoEnhance setting, 2-3, 2-9
Predefined advanced settings, 

2-1 to 2-3
Print Head Alignment utility, 5-8, 

6-4
Print job, deleting, 4-3
Print quality problems, 6-3 to 6-7
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Print Quality setting, 2-5
Print queue, 4-2
Printable area, A-4
Printer driver, accessing

Control Panel, 1-4 to 1-5
Windows applications, 1-2

Printer operation check, 6-2
Printer software, using, 

1-12 to 1-13
Printer status, Windows, 1-6
Problems

diagnosing, 6-1 to 6-2
paper handling, 6-12 to 6-14
print quality, 6-3 to 6-7
printing, 6-7 to 6-12
solving, 6-1 to 6-15
unexpected printout results, 

6-14 to 6-15

Q Quality/Speed slider, 1-3

R Remote systems, network setup, 
4-11

Removing driver, 6-12
Rendering Intent setting, 2-10
Replacing ink cartridges, 5-4 to 5-7
Resolution, 2-5, A-1

S Safety
approvals, A-6
instructions, 7 to 9

Saturation setting, 2-8, 2-10
Self adhesive sheets

choosing, 1-10
printing on, 3-2, 3-7
specifications, A-3

Self test, see Printer operation check
Service, 5 to 6
Single sheets, printing, 3-2
Smears, 3-9

Specifications
electrical, A-6
environmental, A-6
ink cartridge, A-5
interface, A-6
mechanical, A-5
paper, A-3 to A-4
printing, A-1 to A-2

Spool directory, 4-3
Spool Manager

problems, 6-8, 6-10, 6-14
Windows, 4-1 to 4-4

Status Monitor
Macintosh, 4-7
problems, 6-1, 6-10
Windows, 1-6, 4-4

Support, 5 to 6
System requirements

Macintosh, 3
Windows, 2

T Technical specifications, 
A-1 to A-7

Testing printer, 6-2
Text/Graph setting, 2-3
Transfer paper

choosing, 1-10
printing on, 2-6, 3-3, 3-8

Transparencies
choosing, 1-10
printing on, 3-3, 3-5
specifications, A-3

Transporting printer, 5-10
Troubleshooting, 6-1 to 6-15

U User Defined paper size, 3-11
Utilities

Head Cleaning, 5-2
Nozzle Check, 5-2 to 5-4
Print Head Alignment, 5-8
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W What’s This prompt, 1-13
Windows

managing print jobs from, 
4-1 to 4-5

network printing, 4-9 to 4-12
printing from, 1-1 to 1-4

Windows 95
ICM, 2-7 to 2-9
Spool Manager, 4-1 to 4-4

Windows NT
online help, 1-13
setting default printer options, 

1-5
World Wide Web, 5

Y Yellow setting, 2-8
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